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Thank you for purchasing SHARP Digital Signage Software.
SHARP Digital Signage Software comes in three versions: The Standalone, Network, and Viewer Versions. This 
manual covers all three versions. Where editions differ in terms of usage restrictions and functionality, this fact is 
clearly indicated.

IMPORTANT:
To aid reporting in case of loss or theft, 
please record the product’s model and 
serial numbers in the space provided.

Model No.:

Serial No.:

U.S.A. ONLY

Precautions on use
•	This	product	is	subject	to	exacting	quality	control	and	product	inspection	before	shipment.	In	the	unlikely	event	

that a failure or malfunction occurs, contact your retailer.

•	Please	note	that	SHARP	CORPORATION	bears	no	responsibility	for	any	failure,	malfunction,	or	damages	due	
to	improper	use	of	this	product	by	the	customer	or	a	third	party,	except	where	indemnity	liability	is	recognized	
under law.

•	Under	copyright	law,	the	use	of	this	product	to	duplicate,	edit	or	otherwise	alter	copyrighted	material	is	only	
permitted in cases where such duplicated or edited material is for individual or home use.

 If material is duplicated and/or edited beyond this scope, and if such duplicated or edited material is used, 
(except	in	cases	where	the	user	themselves	holds	the	copyright	for	the	object	of	the	duplicated	material	or	
where the user has received permission from the copyright holder), this will constitute a violation of copyright 
law and may lead to the copyright holder or other parties claiming compensation for damages. Such use 
should therefore be strictly avoided.

 When using photo image data, DVD images, TV broadcasts or similar material with this product, the above 
uses	that	constitute	copyright	violation	should,	naturally,	be	strictly	avoided.	Using,	modifying,	or	otherwise	
altering images of other people without permission constitutes a violation of portrait rights, and should also be 
strictly avoided.

•	When	showing	TV,	DVDs,	or	similar	copyrighted	programs	and/or	material	you	must	obtain	the	permission	of	
the copyright holder or copyright holders.

•	Transcribing	or	duplicating	part	or	all	of	this	manual	and/or	this	software	without	permission	from	our	company	
is not permitted.

•	As	a	part	of	our	policy	of	continuous	improvement,	SHARP	reserves	the	right	to	make	design	and	specification	
changes	for	product	improvement	without	prior	notice.	The	performance	specification	figures	indicated	are	
nominal values of production units. There may be some deviations from these values in individual units.

Introduction

Download from Www.Somanuals.com. All Manuals Search And Download.



6

Trademarks
•	Microsoft,	Windows,	Windows	Vista,	PowerPoint,	and	Windows	Media	are	either	registered	trademarks	or	
trademarks	of	Microsoft	Corporation	in	the	United	States	and/or	other	countries.

•	The	Microsoft	Internet	Explorer	logo	is	a	trademark	of	Microsoft	Corporation	in	the	United	States	and	other	
countries.

•	Flash	and	Flash	Player	are	either	registered	trademarks	or	trademarks	of	Adobe	Systems	Incorporated	in	the	
United	States	and/or	other	countries.

•	Intel,	Celeron,	and	Pentium	are	either	registered	trademarks	or	trademarks	of	Intel	Corporation	and/or	its	
subsidiaries	in	the	United	States	and/or	other	countries.

•	QuickTime	and	the	QuickTime	logo	are	trademarks	of	Apple	Computer,	Inc.,	registered	in	the	United	States	
and other countries.

Names of products and other proper nouns are the registered trademarks or trademarks of their respective 
copyright holders.

How to read this manual
This manual describes SHARP Digital Signage Software Version 3.0.

●Icons

indicates reference information, related details, and restrictions.

F indicates pages that contain related information.

●Notation

• Keyboard keys are indicated with square brackets.
E.g.	[Shift],	[Ctrl],	etc.

• Menus, windows, dialog boxes, buttons, and tabs etc are indicated with square brackets.
E.g.
1. From the [Option] menu click [Grid Setting].

The	[Grid	Setting]	dialog	box	will	appear.

• Items, check boxes, and option buttons, etc., are indicated with double inverted commas.
E.g.	“X”,	“Preset	Screen	Size”	option	button,	etc.

• This manual assumes that this product has been installed in the following location.
If you have installed the software in a different location, this can be interpreted to refer to the folder where you 
installed it.

C:\Program Files\SHARP\SHARP Digital Signage Software (default)

• The screenshots and operational procedures in this manual are only examples.
These may change depending on your monitor, screen settings, or the version of the OS you are using and 
other	factors.	This	manual	gives	instructions	using	Windows	XP	as	an	example.
The	content	files	and	fonts	in	this	manual	are	only	examples.	Not	all	of	these	are	included	with	this	software.

• This manual does not contain basic operating instructions for Windows.

Trademarks / How to read this manual
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Definitions
This	chart	provides	definitions	of	terms	used	in	this	manual.

Term Definition

Controller	PC
The	PC	that	is	used	to	create	and	distribute	programs,	timetables	and	schedules.
Also	referred	to	as	a	“Server	PC”.

Target	PC
A	PC	that	displays	content	according	to	a	schedule.
Also	referred	to	as	a	“Panel	PC”	or	a	“Client	PC”.	“Panel”	refers	to	an	LCD	monitor	
connected	to	a	target	PC.

Content	(files)
Material	(i.e.	files)	such	as	movies,	still	images,	and	audio	files	that	are	played	on	the	panel.
These are usually prepared by the user.

Playlist
A list that plays multiple content in a desired order.
Contains	information	such	as	content	data,	order	of	play,	and	duration,	etc.

Frame
Refers to a sub-screen that is used as a display unit when a single panel is divided into 
multiple frames.

Scroll message
A scrolling message.
Up	to	two	scroll	messages	can	be	displayed.

Program
Programs consist of a frame layout, multiple frames and their assigned playlist 
information, scroll message information, etc.

Timetable
Timetables contain information regarding the order and duration of play for multiple 
programs that have been assigned to a one-day time frame.

Schedule Schedules contain multiple timetables assigned to desired dates of play.

Attached	files
The	collective	term	for	the	image	files,	etc,	which	are	required	when	displaying	HTML	files,	
etc.

System operation precautions
Points to note when creating content and programs
Before	operating	the	system,	run	a	test	using	the	actual	content	to	be	displayed	on	the	panel.	If	the	PC	does	not	
have	sufficient	processing	power,	content	may	not	be	played	correctly.	

•	Movie	players
 Playing multiple videos simultaneously is not recommended.
	 Windows	Media	Player	generally	places	a	heavier	load	on	the	CPU	than	Flash	Player	(although	this	depends	

on the content).

	 •	A	separate,	fee-based	codec	may	be	necessary	to	play	video	files.
 •	QuickTime	Player	is	required	in	order	to	play	QuickTime	content.

•	Flash	content
	 Take	care	when	playing	content	that	makes	frequent	use	of	image	transparency	processing	(image	fade-in/
fade-out),	as	this	may	place	an	extremely	heavy	load	on	the	CPU.

•	Enlarging/reducing	still	images	and	movies
	 As	image	size	and	display	size	increase,	so	does	the	load	placed	on	the	CPU.	CPU	load	also	increases	when	
images	are	displayed	at	an	enlarged	or	reduced	size.	Keep	the	size	of	the	content	display	area	(frame	size)	as	
small	as	possible.	Content	should	also	be	created	using	the	same	image	size	as	the	display	size.

•	Still	image	switching	
	 Using	still	image	switching	will	increase	the	load	on	the	CPU.	Its	effect	is	dependent	on	the	performance	of	the	

video card.

Definitions / System operation precautions
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•	Scroll	message	content
	 Displaying	scroll	messages	requires	a	great	deal	of	CPU	processing	power.	When	using	scroll	messages,	

programs should be tested by actually displaying them before operation.
· Making the background color transparent will increase the load.
·	Scroll	messages	with	a	larger	display	area	place	a	larger	load	on	the	PC.	Do	not	make	the	scroll	message	

display area unnecessarily large.
· If there are a lot of characters in a scroll message line, display may become distorted. If this occurs, start a 
new	line.	(Up	to	100	characters	per	line	recommended.)

•	PowerPoint
 Set PowerPoint data so that it plays repetitively by setting slide transition to advance slides automatically 

(automatic slideshow).
	 PowerPoint	Viewer	is	not	capable	of	simultaneous	multiple	display.	Do	not	assign	PowerPoint	files	to	multiple	

frames in the same program. It should also be noted that PowerPoint Viewer only proceeds to play slideshows 
when the focus is on itself. Do not click other frames with the mouse or another tool when PowerPoint content 
is displayed. 

	 The	new	file	format	of	PowerPoint	2007	(.pptx)	is	not	supported.	Save	content	in	ppt	format.
	 PowerPoint	Viewer	2003/2007	is	required.	Even	if	you	already	have	Microsoft	PowerPoint	2003/2007	installed	
on	your	PC,	you	must	make	a	separate	installation	of	PowerPoint	Viewer	2003/2007.

Continuous operation of target PC
This	software	is	not	designed	for	continuous	24-hour-a-day	operation.	Be	sure	to	turn	the	power	off	on	the	
target	PC	every	day.	(Refer	to	Power	Control	on	p.71)

PC internal clock
This	software	executes	schedules	based	on	the	PC’s	internal	clock.	You	should	ensure	that	your	PC’s	
internal	clock	is	always	accurate	by	synchronizing	it	with	an	internet	time	server	or	other	means.

Accuracy of program display time
Program display is controlled by a timer that starts at 0 seconds every minute. Programs cannot be switched at 
intervals	of	less	than	1	minute,	or	during	a	1	minute	interval	(i.e.	in	intervals	of	less	than	60	seconds).
Be aware that there may be some delay before content is actually displayed depending on the time taken to 
launch	applications	that	display	content	and	the	time	taken	to	load	content	files.

Backups
This	software	does	not	have	a	backup	function.	You	should	make	regular	backup	copies	of	content	files,	
etc., during operation.

Daisy chain configuration
This	software	cannot	send	different	panel	control	commands	(monitor	power	supply	ON/OFF	and	panel	input	
commands)	to	individual	SHARP	LCD	monitors	(PN	series)	connected	in	a	daisy	chain.

Still images
The Network Version of SHARP Digital Signage Software can send different panel control commands (monitor 
power	supply	ON/OFF	and	panel	input	commands)	to	SHARP	LCD	Monitors	(PN	Series)	connected	in	a	daisy	
chain.	(Refer	to	Panel	Management	and	Option,	p.	78)

Date display
This	software	displays	the	date	in	YYYY/MM/DD	format.

System operation precautions
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Features of SHARP Digital Signage Software
SHARP Digital Signage Software is SHARP’s original content distribution and display software.

Easy-to-use user interface
Programs can be laid out in editable time schedules similar to newspaper TV guides or calendar-style monthly 
schedules.

Variety of display options and scroll message function
Frames	with	completely	customizable	layout	(x4,)	as	well	as	backgrounds	and	scroll	messages	(x2)	can	be	
used.	Vertical	scroll	messages	are	also	supported,	allowing	effective	expression	and	information	display.

Reserved distribution function
Makes	it	possible	to	distribute	reserved	content	over	an	LCD	monitor	network.

Monitor control and break-in distribution functions
Turn monitors on and off and distribute break-in programs during emergencies for smooth monitor control.

Program distribution workflow
This chart details the process from program creation to the stage where programs can be displayed on a panel.

Standalone Version

Lay out your chosen content and create a program. (p.28) 

1  Program Editor 

Assign the hour of the day that your program will be shown. (p.60)

2  Timetable Editor 

Assign the dates when daily timetables you have created will be shown. (p.70)

3  Schedule Editor 

Distribute schedules and programs you have 
created to Client Scheduler. (p.84)

4  Schedule Distribution Tool 

Control Program Viewer so that it displays schedules and programs at a set time. (p.99)

5  Client Scheduler 

Program Viewer displays programs when instructed to do so by Client Scheduler. (p.105)

6  Program Viewer 

Program 
displayed 

 
You can distribute to a target PC 
that has Program Viewer installed 
by using USB memory or other 
external storage devices. (p.104)

 

(Standalone Version) 

Features of SHARP Digital Signage Software / Program distribution workflow
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Network Version

Lay out your chosen content and create a program. (p.28) 
1  Program Editor 

Assign the hour of the day that your program will be shown. (p.60)
2  Timetable Editor 

Assign the dates when daily timetables you have created will be shown. (p.70)
3  Schedule Editor 

Distribute schedules and programs you have created
to a target PC connected to the network. (p.84)

4  Schedule Distribution Tool 

Control the distribution schedule and distribute 
scheduled times to the FTP server. (p.97)

Server Scheduler 

The FTP server passes schedules and programs it receives to Client Scheduler. (p.98)

5  FTP Server 

Control Program Viewer so that it displays schedules and programs at a set time. (p.99)

6  Client Scheduler 

Program Viewer displays programs when instructed to do so by Client Scheduler. (p.105)

7  Program Viewer 

Program 
displayed 

Controller PC  
(Network Version) 

Target PC 
(Viewer Version) 

 You can distribute to a target PC 
that has Program Viewer installed 
by using USB memory or other 
external storage devices. (p.79) 

Schedules and programs can be loaded from USB  
memory or other external storage devices. (From      ) 

 

Distributed via a network 

Obtain panel status data and control 
target PC power. (p.112)

Status Monitoring Tool 
 

Program distribution workflow
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Installing/Launching
This section provides installation instructions and information regarding the necessary operating environment, 
as well as instructions on how to start and close down SHARP Digital Signage Software. Be sure to read this 
before using the software.

Required operating environment

Item Description

PC
CPU:	Celeron	M	1.3	GHz	or	higher	
2	GHz	or	higher	Pentium	4	processor	is	recommended	for	movie/content-heavy	
programs.

OS
Microsoft	Windows	XP,	Windows	Vista,	Windows	7	(English	version),	
Windows	Server	2003/2008	(English	version)

Memory 256	MB	or	higher	(512	MB	or	higher	recommended)
Hard disk 20	MB	or	more	free	space	(Additional	space	required	for	saving	data)
Monitor	(for	controller	PC)	*1 Full	color	display	with	resolution	of	at	least	1024	x	768

Monitor	(for	target	PC)	*2
PN	series	LCD	monitor
LB-1085	*3,	LB-46GX35	*4,	LB-52GX35	*4

Interfaces
•	USB	port	(only	required	if	using	USB	memory)
•		LAN	port	(only	required	for	Network	Version	[TCP/IP	communication	must	
be	functional])

Others

Microsoft	Internet	Explorer	6.0	or	later
PowerPoint	Viewer	2003/2007
Windows Media Player 9 or later
Flash	Player	6	or	later
QuickTime	Player	7	or	later	(in	order	to	play	QuickTime	content)

If	there	are	any	environmental	requirements	for	the	OS	to	operate	besides	the	above,	they	must	also	be	met.
If the OS of the target PC is Windows Vista or Windows 7, disable the user account control of the target 
PC.
*1	 Used	for	creating/editing	programs	and	schedules.
*2	 Used	to	display	programs	with	the	Standalone	and	Viewer	Versions. 

Panel	control	can	be	performed.	To	perform	panel	control,	the	target	PC	and	the	panel	must	be	connected	
with	an	RS-232C	cable	or	the	panel	must	be	connected	to	the	LAN.	For	the	specifications	of	the	panel	and	
its connection and setting methods, read the operation manual of your panel.

*3	 To	perform	panel	control	with	the	LB-1085,	perform	a	“Test	connection”	once	with	the	SHARP	Digital	
Signage	Software	Client	Scheduler	(Fp.92).

	 The	panel	control	cannot	be	performed	unless	a	“Test	connection”	is	performed.
*4	 For	Japanese	market	only.

	 •	When	controlling	the	target	PC	manually	(when	turning	the	panel	PC	on),	the	Wake	On	LAN	function	
that	operates	by	Magic	Packets	from	the	target	PC	must	be	enabled.

 	 If	the	target	PC	is	outside	the	same	LAN	segment,	Magic	Packets	may	not	get	through	depending	on	
router	specs/settings.	Contact	your	network	administrator	for	more	details.

 •	Regardless	of	which	version	of	this	software	you	are	using,	you	must	have	Flash	Player,	Windows	Media	
Player,	and	PowerPoint	Viewer	2003/2007	installed	on	the	PC	on	which	this	software	is	installed.

  If you have not installed all of these programs, or have installed different versions of them, a message 
prompting you to install may appear. If this happens, download the appropriate programs from the 
relevant website and install them.

 •	A	separate,	fee-based	codec	may	be	necessary	to	play	video	files.
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Installing SHARP Digital Signage Software

	 You	must	log	in	as	an	administrator	before	beginning	the	installation	process.

●Installing SHARP Digital Signage Software
1. Start your PC
2. Close down all applications.
3. Launch the SHARP Digital Signage Software setup program (setup.exe).

Double-click	the	setup.exe	file	to	launch	the	setup	program.

	 If	a	security	warning	saying	‘The	publisher	could	not	be	verified.’	is	displayed	during	the	installation,	
click	[Run].

If using the “SHARP Digital Signage Software CD-ROM”
1)	 If	the	setup	program	is	launched	automatically,	proceed	

to	step	4.	If	the	setup	program	does	not	launch	after	a	
few	moments,	launch	the	Setup.exe	file	in	the	CD-ROM	
folder.

2)	 In	the	[AutoPlay]	dialog	box,	click	“Run	setup.exe”.
	 If	the	[AutoPlay]	dialog	box	does	not	appear,	double-click	

the	Setup.exe	file	in	the	CD-ROM	folder.

3)	When	the	[User	Account	Control]	dialog	box	
appears,	click	[Allow]	(for	Windows	Vista)	or	[Yes]	(for	
Windows	7).

4. In the [Welcome to the Install Shield wizard...] window, 
click [Next].

Installing SHARP Digital Signage Software
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5. Software license agreement will appear.  
Read the entire software license agreement.

6. If you agree to the terms of the agreement, select the “I accept the terms of the license agreement” 
option button, and click [Next].

7. Select the version that you have purchased and click [Next].
The three following versions are available:
	•	 [PN-SS01]	Standalone	Version
	 For	creating	programs	and	distributing/displaying	schedules	

with	a	single	PC.
	•	 [PN-SS02]	Network	Version
	 For	use	on	a	controller	PC	to	create	programs,	distribute	

schedules, and check panel status.
	 Also	used	for	distributing	programs	and	schedules	to	target	PCs	

running	the	“Viewer	Version”.
	•	 [PN-SV01]	Viewer	Version
 Only installs software for content display.
	 For	use	on	a	target	PC.	Displays	received	programs	according	to	a	schedule.

8. Enter the appropriate license code for your version and click 
[Next].

 If you entered a temporary license code, you will only be 
able	to	use	the	software	for	a	two-month	trial	period.	You	
should register the license code you obtained before the 
end of the trial period.

 •	If	you	are	using	the	Standalone	or	Network	Version,	
license	codes	can	be	registered	using	the	[Register	
License	Code]	dialog	box	from	the	[Option]	menu.	
(Fp.73)

 •	If	you	are	using	the	Viewer	Version,	license	codes	can	be	registered	from	the	[Version]	dialog	box	
in	Client	Scheduler.	(Fp.93)

9. Click [Next].

 If you want to change the location where the installation will 
be	made,	click	[Change]	and	specify	a	different	directory.

Installing SHARP Digital Signage Software
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10. Click [Install].
The installation will start.

11. Click [Finish].
The installation is now complete.

	 If	the	following	screen	appears,	click	[Yes]	to	restart	your	
PC.

If you are using the Standalone or Network Versions, a shortcut to SHARP Digital Signage Software will be 
created on your desktop.

If	you	are	using	the	Standalone	or	Viewer	Versions,	Client	Scheduler	( ) will launch and appear in the 
Task Tray.
If you are using the Network Version, Server Scheduler ( )	and	Client	Scheduler	( ) will launch and 
appear in the Task Tray.

Installing SHARP Digital Signage Software
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●Setting the environment of the target PC 
Once	the	installation	is	complete,	change	the	settings	of	the	target	PC	before	using	this	software.	A	
description	is	given	below,	using	Windows	XP/Vista/7	as	an	example.

Auto login settings
If	the	target	PC	is	to	be	used	without	an	operator,	Windows	auto	login	should	be	enabled.
If using Windows Vista, use the following procedure to enable auto login.

1. From the Windows Taskbar, click [Start], [All Programs], [Accessories], and then [Command 
Prompt].
The	[Command	Prompt]	window	will	appear.

2. Type in “control userpasswords2” (without the inverted 
commas) and push [Enter].

3. If the [User Account Control] window appears, click 
[Continue].
The	[User	Accounts]	dialog	box	will	appear.

4. Clear the “Users must enter a user name and password 
to use this computer” check box.

5. Click [OK].

6. In the [Automatically Log On] window, enter a “User 
Name” and “Password”, and click [OK].

7. Type in “exit” and then press [Enter].

Installing SHARP Digital Signage Software
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Welcome Center settings (Windows Vista only)

	 These	settings	do	not	apply	to	Windows	XP/7.

Under	default	settings,	the	“Welcome	Center”	is	displayed	when	
Windows Vista is started.
Clear	the	“Run	at	startup”	check	box,	to	stop	the	“Welcome	
Center”	from	being	displayed	when	a	program	is	displayed	in	
Program	Viewer.	The	“Welcome	Center”	will	not	appear	from	the	
next	time	the	PC	is	started.

	 If	“Welcome	Center”	is	closed	you	can	display	it	using	
either of the following methods.

 •		From	the	Windows	Taskbar,	click	[Start],	[Control	Panel],	
[System	and	Maintenance],	and	then	[Welcome	Center].

	 •		From	the	Windows	Taskbar,	click	[Start],	[All	Programs],	[Accessories],	and	then	[Welcome	Center].

Screen saver settings
Disable the screen saver so that it does not display on the monitor when a program is displayed in Program 
Viewer.

•If using Windows XP
1. Right-click on an empty area of the desktop, and from the menu that appears, click [Properties].

The	[Display	Properties]	dialog	box	will	appear.
2. Click the [Screen Saver] tab and select “(None)” from the 

“Screen saver” list.
3. Click [OK].

Installing SHARP Digital Signage Software
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• If using Windows Vista/7
1. Right-click on an empty area of the desktop and from the menu that appears, click [Personalize] and 

then [Screen Saver].
The	[Screen	Saver	Settings]	dialog	box	will	appear.

2. Select “(None)” from the “Screen saver” list.
3. Click [OK].

Power control
Adjust	settings	so	that	the	panel	or	hard	disk	do	not	turn	off	or	go	into	system	standby	while	a	program	is	
displayed in Program Viewer.

•If using Windows XP
1. From the Windows Taskbar, click [Start], [Control Panel], [Performance and Maintenance], and then 

[Power Options].
The	[Power	Options	Properties]	dialog	box	will	appear.

2. Select “Never” from the “Turn off monitor”, “Turn off 
hard disks”, and “System standby” pull-down menus on 
the [Power Schemes] tab.

3. Click [OK].

Installing SHARP Digital Signage Software
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• If using Windows Vista
1. From the Windows Taskbar, click [Start], [Control Panel], [System and Maintenance], and then 

[Power Options].
The	[Power	Options]	dialog	box	will	appear.

2. Select “High performance” and click [Change plan 
settings].

3. Select “Never” from the “Turn off the display” and “Put 
the computer to sleep” lists.

4. Click [Save changes].
Return	to	the	[Power	Options]	dialog	box.

5. Close the [Power Options] dialog box by clicking the 
 button in the upper right corner of the window.

• If using Windows 7
1. From the Windows Taskbar, click [Start], [Control Panel], [System and Security], and then [Power 

Options].
The	[Power	Options]	dialog	box	will	appear.

2. Click “Show additional plans” select “High performance” 
and click [Change plan settings].

3. Select “Never” from the “Turn off the display” and “Put 
the computer to sleep” lists.

4. Click [Save changes].
Return	to	the	[Power	Options]	dialog	box.

5. Close the [Power Options] dialog box by clicking the  button in the upper right corner of the 
window.

Windows Sidebar (Gadget) settings (Windows Vista Only)

	 These	settings	do	not	apply	to	Windows	XP/7

Adjust	Windows	Sidebar	(Gadget)	settings	so	that	the	Sidebar	(Gadgets)	is	not	displayed.

1. Right-click on an empty area of the Windows Sidebar, 
and from the menu that appears, click [Properties].
The	[Windows	Sidebar	Properties]	dialog	box	will	appear.

Installing SHARP Digital Signage Software
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2. Clear the “Start Sidebar when Windows starts” check 
box.

3. Click [OK].
4. Restart your PC.

The	Windows	Sidebar	(Gadgets)	will	no	longer	appear	from	the	
next	time	you	start	Windows	Vista.

Active desktop settings (Windows XP Only)
Turn Active desktop settings off.

 These settings do not apply if you are using Windows Vista.

1. Right-click on an empty area of the desktop, and from the menu that appears, click [Properties].
The	[Display	Properties]	dialog	box	will	appear.

2. Click the [Desktop] tab, and then click [Customize Desktop].
The	[Desktop	Items]	dialog	box	will	appear.

3. Click the [Web] tab and clear all the check boxes under 
“Web pages”.

4. Click [OK].

IME Toolbar settings
These	settings	are	not	required	if	the	IME	Toolbar	is	not	displayed.
Store	the	IME	Toolbar	in	the	Taskbar	so	that	it	is	not	displayed	when	a	program	is	being	displayed	in	Program	
Viewer.
1. Right-click on the IME Toolbar and, from the menu that appears, click [Minimize].
 You can also click  to minimize the Toolbar.

Installing SHARP Digital Signage Software
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Taskbar settings (Windows XP/Vista only)
Adjust	the	Taskbar	settings	so	that	the	Taskbar	is	not	displayed	when	a	program	is	being	displayed	in	Program	
Viewer.
1. Right-click on an empty area of the Taskbar, and from the menu that appears, click [Properties].

The	[Taskbar	and	Start	Menu	Properties]	dialog	box	will	appear.
2. Under “Taskbar appearance” on the [Taskbar] tab, clear 

the “Auto-hide the taskbar” and “Keep the taskbar on 
top of other windows” check boxes.

3. Click [OK].

Windows Update settings
Set	Windows	Update	so	that	it	does	not	update	automatically	and	display	popup	messages	(dialog	boxes),	etc.,	
while a program is being displayed in Program Viewer.

	 If	you	have	disabled	automatic	updates,	remember	to	check	the	Windows	Update	website	 
(http://windowsupdate.microsoft.com/) regularly and download and install updates manually. Not installing the 
latest updates is a security risk and may also lead to performance related issues.

•If using Windows XP
1. From the Windows Taskbar, click [Start], [Control Panel], [Performance and Maintenance], and then 

[System].
The	[System	Properties]	dialog	box	will	appear.

2. Click the [Automatic Updates] tab and select the “Turn 
off Automatic Updates” option button.

3. Click [OK].
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•If using Windows Vista
1. From the Windows Taskbar, click [Start], [Control Panel], [Security], and then [Turn automatic 

updating on or off].
The	[Change	settings]	dialog	box	will	appear.

2. Select the “Never check for updates” option button.
3. Click [OK].

4. If the [User Account Control] window appears, click [Continue].
The	[Change	settings]	dialog	box	will	close.

•If using Windows 7
1. From the Windows Taskbar, click [Start], [Control Panel], [System and Security], and then [Turn 

automatic updating on or off].
The	[Change	settings]	dialog	box	will	appear.

2. From the menu of “Important updates,” select the “Never 
check for updates (not recommended)” option button.

3. Click [OK].

4. If the [User Account Control] window appears, click [Yes].
The	[Change	settings]	dialog	box	will	close.

Resident application settings
Adjust	settings	for	resident	applications	(e.g.	virus	scanners)	so	that	they	do	not	display	popup	messages	(dialog	
boxes)	when	a	program	is	being	displayed	in	Program	Viewer.
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Personal firewall settings
If	you	plan	to	distribute	content	over	a	network,	you	must	free	a	TCP/IP	port	for	this	software	to	use	when	the	
distribution	port	is	assigned	to	a	personal	firewall.

	 If	you	have	installed	the	Viewer	Version,	a	unique	FTP	server	will	be	installed,	and	started	as	a	service.	
The	default	TCP/IP	port	numbers	are	20	and	21.	If	you	change	the	port	number,	you	must	also	change	
the	FTP	settings	for	the	controller	PC	(Fp.80),	and	the	FTP	settings	for	Client	Scheduler	on	the	target	
PC	(Fp.101)	to	the	same	port	number.

Firewall settings for Status Monitoring Tool (Windows Vista/7 Only)
If	using	Windows	Vista/7,	use	the	following	procedure	to	change	these	settings.
1. From the Windows Taskbar, click [Start], [Control Panel], [System and Maintenance] (for Windows 

Vista) or [System and Security] (for Windows 7), and then [Administrative Tools].

2. Double-click “Windows Firewall with Advanced Security”.

3. If the [User Account Control] window appears, 
click [Continue] (for Windows Vista) or [Yes] (for 
Windows 7).
The	[Windows	Firewall	with	Advanced	Security]	dialog	box	
will appear.

4. On the left of the window, click [Inbound Rules], then 
click “New Rule” under [Actions] in the pane on the right 
of the window.
The	[New	Inbound	Rule	Wizard]	dialog	box	will	appear.
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5. Select the “Custom” option button, and click [Next].

6. Select the “All programs” option button, and click [Next].

7. From the “Protocol type” list, select “ICMPv4”.

8. Set “Protocol and Ports”, “Scope”, “Action”, and 
“Profile” in order as necessary. Click [Next] to be taken 
to the settings screen for the next step.

	 Confirm	with	your	network	administrator	before	
adjusting	these	settings.

9. Enter a “Name”, and click [Finish].

10. Close the dialog boxes by clicking the  button at 
the top right of each window.

Installing SHARP Digital Signage Software
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●Uninstalling SHARP Digital Signage Software
If	this	software	frequently	shuts	down	incorrectly	when	a	program	is	being	displayed	or	created,	you	should	
modify the program. If the problem persists even after doing so, we recommend uninstalling, then reinstalling 
this software.

	 Uninstalling	this	software	will	not	delete	any	programs,	schedules	or	content	files	that	you	have	already	
created.	You	will	be	able	to	use	these	files	again	upon	reinstalling	this	software.

1. Start your PC.
2. Close down all applications.
3. Launch the SHARP Digital Signage Software setup maintenance program (setup.exe).

Double-click	the	setup.exe	file	to	launch	the	setup	maintenance	program.

	 If	a	security	warning	saying	‘The	publisher	could	not	be	verified.’	is	displayed	during	the	installation,	
click	[Run].

If using the “SHARP Digital Signage Software CD-ROM”
1)	 If	the	setup	program	is	launched	automatically,	proceed	

to	step	4.	If	the	setup	maintenance	program	does	not	
launch	after	a	few	moments,	launch	the	Setup.exe	file	in	
the	CD-ROM	folder.

2)	 In	the	[AutoPlay]	dialog	box,	click	“Run	setup.exe”.
	 If	the	[AutoPlay]	dialog	box	does	not	appear,	double-click	

the	Setup.exe	file	in	the	CD-ROM	folder.

3)	When	the	[User	Account	Control]	dialog	box	
appears,	click	[Allow]	(for	Windows	Vista)	or	[Yes]	(for	
Windows	7).

4. Select the “Remove” option button, and click [Next].

	 If	you	select	the	“Modify”	option	button,	you	will	have	to	
re-enter a license code.
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5. Click [Yes].
The uninstallation will start.

	 If	the	Server	Scheduler	or	the	Client	Scheduler	has	been	started,	a	message	will	appear.	In	this	
case,	click	[Yes].	The	Server	Scheduler	and	the	Client	Scheduler	will	be	forcibly	terminated	and	the	
uninstallation will continue.

6. Click [Finish].
The uninstallation is now complete.

Installing SHARP Digital Signage Software

Download from Www.Somanuals.com. All Manuals Search And Download.



26

Launching and closing the Launcher window

●Launching the Launcher window
1. On the desktop, double-click the  short cut.

The	Launcher	window	will	launch.

	 The	Launcher	can	also	be	started	by	going	to	the	Windows	Taskbar	and	clicking	[Start],	[All	Programs],	
[SHARP	Digital	Signage	Software],	and	then	[SHARP	Digital	Signage	Software].

●Closing the Launcher window
1. Click  on the Launcher window.

The	Launcher	window	will	close.

●The Launcher window
The	Launcher	window	is	the	window	from	which	operations	are	started.
There	are	six	buttons	for	different	functions	such	as	program	creation	and	program	distribution.	

	 If	another	tool	or	dialog	box	is	already	launched,	it	will	be	displayed	in	the	foreground.

2)		Program	creation/
editing

3)  Timetable 
creation/editing

4)		Schedule	creation/
editing

5)		Schedule	distribution

6)		Panel	control 7)	Option

1)		Button	
description 
window

1) Button description window
When	the	cursor	is	placed	over	a	button,	an	explanation	of	the	button’s	function	is	displayed	in	this	window.

2) Program creation/editing (Fp.28)
This	button	launches	“Program	Editor”.	Program	Editor	lets	you	create	programs	by	setting	screen	sizes	and	
layouts, as well as content and scroll messages.

Launching and closing the Launcher window
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3) Timetable creation/editing (Fp.60)
This	button	launches	“Timetable	Editor”.	Timetable	Editor	lets	you	create	one-day	timetables	by	assigning	
programs you have created to be shown at desired times.

4) Schedule creation/editing (Fp.70)
This	button	launches	“Schedule	Editor”.	Schedule	Editor	lets	you	create	schedules	by	assigning	timetables	you	
have	created	to	be	executed	on	desired	dates.

5) Schedule distribution (Fp.84)
This	button	launches	“Schedule	Distribution	Tool”.	Schedule	Distribution	Tool	lets	you	send	the	schedules	you	
have	created	to	specified	panels.

6) Panel control (Fp.78)
This	button	launches	the	[Panel	Management]	dialog	box.	When	distributing	programs	to	multiple	panels	using	
the	Network	Version,	you	can	register	and	control	panels	from	this	dialog	box.

 This function is only available with the Network Version.

7) Option (Fp.82)
This	button	launches	the	[Option]	dialog	box.	This	dialog	box	displays	version	information	about	the	Launcher,	
and also lets you register license codes.

Launching and closing the Launcher window
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Program Editor

Program Creation/Editing
Create	programs	(content)	to	display	on	a	panel.

The main Program Editor window

●Launching Program Editor
1.  Click   on the Launcher window.

“Program	Editor”	will	launch.

As	soon	as	Program	Editor	launches,	four	pre-defined	frames	and	two	scroll	messages	for	creating	new	
programs will be displayed in the main window. Programs are completed by setting program content in this 
window.

	 •	Program	Editor	can	also	be	started	by	going	to	the	Windows	Taskbar,	and	clicking	[Start],	[All	Programs],	
[SHARP	Digital	Signage	Software],	[Tools],	and	then	[Program	Editor].	

 •	The	first	time	Program	Editor	is	launched,	the	[Content	Preview]	window	will	appear.	(Fp.36)	
 •	If	QuickTime	Player	and	PowerPoint	Viewer	are	not	installed,	a	message	will	appear.

●The main Program Editor window
1)	Title	bar

2)	Menus

3) Toolbar

4)	Tabs

5)	Settings	window

1) Title bar
The name of the program will be displayed here. 
When	Program	Editor	launches,	the	title	bar	will	read	“Untitled”.	When	a	program	is	saved,	it	will	change	to	the	
name of the program. When content of an opened program is changed, the title bar will display an asterisk (*) 
after the program name.
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Program Editor

2) Menus
Menu options are as follows:

Menu option Description Relevant 
page

File

Create	New	Program Opens a new program. -
Open Program Loads	a	saved	program. Fp.47
Save Program Overwrites the currently edited program. Fp.45
Save Program As Saves the currently edited program under a different name. Fp.46
Delete Program Allows the user to specify and delete programs. Fp.48

Properties of Program
Displays program properties and allows the user to change 
them. Fp.49

Import Program
Reads	a	program	that	has	been	exported	from	another	PC	
so that it can be used. Fp.51

Export	Program
Writes out a saved program so that it can be used on 
another	PC. Fp.50

Exit Exits	Program	Editor. -

View

Preview Program
[Original	size]

Displays a preview of the currently edited program at its 
original	size. Fp.47

Preview Program
[Fit	screen]

Displays	a	preview	of	the	currently	edited	program	fitted	to	
the	size	of	the	screen. Fp.47

Set	Configuration	before	
Preview Program

Check	this	option	when	previewing	programs.	Sets	and	
displays display conditions. Fp.48

Refresh
Updates	the	Content	folder	to	reflect	additions	or	deletions	of	
content	files.

-

Option Grid	Setting
Allows	the	user	to	fine	tune	grid	settings	for	positioning	
frames and scroll messages with the grid. Fp.33

Help About	Program	Editor Displays	version	information	for	Program	Editor. -

3) Toolbar
The toolbar buttons perform the following actions:

Icon Menu option Description Relevant 
page

Open Program Loads	a	saved	program. Fp.47

Save Program Overwrites the currently edited program. Fp.45

Properties of Program
Displays program properties and allows the user to change 
them Fp.49

Preview Program
[Original	size]

Displays a preview of the currently edited program at its 
original	size. Fp.47

Preview Program
[Fit	screen]

Displays	a	preview	of	the	currently	edited	program	fitted	to	
the	size	of	the	screen. Fp.47

4) Tabs
Clicking	a	tab	switches	to	the	settings	window	for	each	item.

5) Settings window
Allows the user to set advanced settings for the selected tab.

The main Program Editor window
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Program Editor

Creating programs

●Valid content files
File	types	that	can	be	used	as	content	are	as	follows:

Content name File type
Background,
Frames	1-4

MPEG,	MPEG-1,	MPEG-2,	MPEG-4,
WMV	(Windows	Media	Video	–	file	type	playable	with	Windows	Media	Player),
Flash	(file	type	playable	with	Flash	Player),	Conditional	content	(.dcv)	for	background,	frames,
MOV	(file	type	playable	with	QuickTime	Player),
PowerPoint,	HTML,	JPEG,	BMP,	GIF,	PNG

Scroll	messages	1-2 Scroll	messages	created	in	Scroll	Message	Editor,	Conditional	content	(.dct)	for	scroll	
messages 

Audio WAVE,	MP3,	AU,	AIFF,
WMA	(Windows	Media	Audio	–	file	type	playable	with	Windows	Media	Player),
MOV	(file	type	playable	with	QuickTime	Player),
MIDI,	Conditional	content	(.dca)	for	audio

	 Audio	files	cannot	be	positioned	in	the	layout.	They	are	used	as	audio	or	music	(background	music)	that	
plays while a program is displayed.

Content	files	are	recognized	by	their	file	extensions.
Certain	file	types	require	the	installation	of	corresponding	software.

File extension Content type Required software
.avi .mpeg .mpg .wmv .asf

Movie
Windows Media Player

.mov QuickTime	Player

.swf Flash Flash	Player

.ppt .pps PowerPoint PowerPoint Viewer

.htm .html HTML Internet	Explorer

.tlp Scroll message None

.wav .mp3 .au .aif .aiff 

.wma .mid .midi Audio
Windows Media Player

.mov QuickTime	Player

.jpeg	 .jpg	 .gif	 .png	 .bmp Still image None

	 •	The	JPEG	file	supports	the	RGB	format	but	does	not	support	the	CMYK	format.	In	addition,	JPEG2000	
is not supported.

 •	Animation	GIF	is	not	supported.
 •	Two	or	more	PowerPoint	files	cannot	be	displayed	at	the	same	time.
 •	The	new	file	format	of	PowerPoint	2007	(.pptx)	is	not	supported.	Create	content	in	ppt	format.
 •	The	PowerPoint	content	does	not	support	the	following: 

	 Execution	of	macros,	execution	of	programs,	display	of	link	objects,	display	of	embedded	objects
 •	If	too	many	animations	are	used	in	the	PowerPoint	content,	displayed	characters	may	be	illegible.
 •	The	font	used	in	the	content	must	also	be	installed	on	the	target	PC.
 •	The	HTML	file	and	the	Web	page	cannot	be	enlarged	or	reduced.
 •	Adjustment	of	the	sound	volume	supports	video	and	audio.	It	does	not	support	Flash	and	PowerPoint.

Creating programs
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Program Editor

●Positioning content (Layout)

[Layout]	window

Screens	and	content	size	and	position,	etc.,	are	set	in	the	
[Layout]	window.

	 When	“Layout	Locked.”	is	displayed	in	the	center	of	the	layout	window,	the	layout	cannot	be	
edited.

 Clear	the	“The	layout	edit	is	locked.”	check	box	in	the	[Properties	of	Program]	dialog	box	(Fp.49).
1. Check that the [Layout] tab is selected.

If	it	is	not,	click	the	[Layout]	tab	to	select	it.

2. Set a [Screen Top-Left Position].
Set the coordinates (-9999 - 9999) for where you want the 
top left hand corner of the background to be positioned in the 
panel.
“X”	and	“Y”	are	usually	set	to	“0”.	(Default)

3. Set the “Screen Size”.
The	screen	size	is	the	size	of	the	background.
Select	the	“Preset	Screen	Size”	option	button,	and	choose	a	
size	from	the	list.
This	is	usually	set	to	the	size	of	the	panel	(i.e.	panel	
resolution).

	 •	If	the	size	you	want	is	not	in	the	list,	select	the	
“Custom	Screen	Size”	option	button,	and	enter	a	
size.

 •	To	change	the	preset	screen	sizes	in	the	list,	edit	the	“ScreenSize.dat”	file	found	in	the	folder	
where	you	installed	this	software	(the	default	directory	is,	C:\Program	Files\SHARP\SHARP	Digital	
Signage	Software)	specifying	sizes	in	order	of	“width”	then	“height”	as	in	the	examples	below.

 	 		1280,1024
 	 		1920,1080
 	 		1024,768
 	 When	you	start	Program	Editor	the	screen	size	on	the	first	line	will	be	selected.
 •	If you want to combine multiple panels and have 

them	displayed	as	one	panel,	click	[Calculate	
screen	size	for	Multi	display]	and	set	the	screen	
size	simply	by	selecting	the	model	name	and	
direction.
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4. Set [Frame Layout].
1)	Check	the	checkboxes	beside	the	frames,	scroll	

messages, or PIP that you want to display.

	 You	can	also	click	the	  button at the top right 
hand corner of a frame or scroll message to hide it. 

2)	Set	“X	”,	“Y	”,	“Width”,	and	“Height”	coordinates	for	each	
frame or scroll message.

	 •	Only	“X	”	and	“Y	”	coordinates	can	be	adjusted	for	
the	PIP	frame.	To	adjust	the	size	of	the	PIP	frame,	
click	the	[PinP]	tab,	and	specify	a	“Value”	for	the	
“Size”	under	“Key”.

 •	Click	on	a	frame	or	a	scroll	message	to	select	it.	
Eight	resize	handles	will	appear	around	the	border	
of the frame. By dragging these handles with the 
mouse,	you	can	resize	a	frame	or	scroll	message,	
and	confirm	changes	visually. 
The frame and scroll messages can be moved by 
dragging	an	area	other	than	the	resize	handle	using	
the mouse.

 ·	Dragging	while	holding	down	[Shift]	allows	you	to	resize	a	frame	while	keeping	the	same	aspect	
ratio.

 ·	You	can	also	move	frames	or	scroll	messages	using	the	arrow	keys.
 · You	will	still	be	able	to	adjust	the	size	of	a	frame	if	you	hold	down	[Shift]	while	using	the	arrow	keys.

	 •	You	can	move	or	resize	items	accurately	by	aligning	them	with	the	grid.	(Fp.33)

E.g.
Frame1:	 X	=	25,	 Y	=	20,	 Width	=	1338,		 Height	=	835
Frame2:	 X	=	1380,	 Y	=	25,	 Width	=	523,	 	 Height	=	830
Message1:	 X	=	20,	 Y	=	869,	 Width	=	1883,		 Height	=	194
PIP:	 X	=	576,	 Y	=	395
The above coordinates would produce a layout like the screenshot below.

	 •	The	name,	position	and	dimensions	
(X	coordinate	of	top	left	corner,	
Ycoordinate	of	top	left	corner,	width,	
height) are displayed in the top left of 
each frame or scroll message.

 •	The	PIP	frame	cannot	be	moved	in	1	pt	
increments.	Locations	where	items	can	
be positioned depend on the kind of 
LCD	monitor	used.
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Using the grid
Using	the	grid	makes	it	easy	to	position	items	accurately.	Items	can	be	dragged	with	the	mouse	and	aligned	on	
the grid. The grid can be set with the following procedure:
1. From the [Option] menu click [Grid Setting].

The	[Grid	Setting]	dialog	box	will	appear.
2. Set the “Frame Layout”.

Check	the	“Frame	position	in	Grid”	check	box	to	use	the	grid.
Clear	the	check	box	to	position	frames	in	1	pt	increments.

3. Set the “Interval” for the grid.
Enter	a	whole	number	between	2-100	pt.	(The	default	value	
is	8	pt)

	 •	Show	or	hide	the	grid	by	checking	or	clearing	the	“Show	Grid”	check	box.	Even	if	the	grid	is	hidden,	if	
you	have	checked	the	“Frame	position	in	Grid”	check	box,	frames	will	be	aligned	to	the	grid	when	moved	
or	resized.

 •	Even	if	you	have	checked	the	“Frame	position	in	Grid”	check	box,	you	will	be	able	to	ignore	the	grid	and	
move	items	in	1	pt	increments	by	doing	the	following:

 ·	Dragging	an	item	while	holding	down	[Ctrl].	This	will	allow	you	to	ignore	the	grid	when	resizing.	
 ·	Dragging	an	item	while	holding	down	[Shift]	+	[Ctrl].	This	will	allow	you	to	maintain	the	aspect	ratio	of	a	

frame	while	you	resize	it	and	ignore	the	grid	at	the	same	time.
 ·	Holding	down	[Ctrl]	while	using	the	arrow	keys.	This	will	allow	you	to	move	items	in	1	pt	increments.
 ·	Holding	down	[Shift]	+	[Ctrl]	while	using	the	arrow	keys.	This	will	allow	you	to	resize	items	in	1	pt	

increments.

Display priority order

Background

Frame1

Frame2

Frame3

Frame4

If frames overlap when a program is displayed, programs will be 
displayed in the following order from foreground to background.
“Frame4” → “Frame3” → “Frame2” → “Frame1” → “Background”

	 •	The	display	priority	order	cannot	be	set.
 •	If	the	content	of	the	frame	or	background	is	a	PowerPoint	

or	EXE	file,	it	will	be	displayed	in	the	foreground,	
regardless of the display priority order.

 •	Scroll	messages	are	displayed	ahead	of	the	background	
frame.

 •	In	all	cases,	the	PIP	frame	is	displayed	ahead	of	the	background,	frame,	and	scroll	messages.
 •	If	movies	are	displayed	in	the	background,	they	may	be	displayed	in	front	of	other	frames	in	some	

cases.	Set	movies	in	frames	1-4,	not	the	background.

Using a layout you have created
Click	[Save	Layout]	to	save	the	Layout	you	have	created.	The	next	time	you	come	to	create	a	program	you	will	
then	be	able	to	click	on	[Open	Layout]	to	use	the	saved	layout.

 When you save a layout, frame settings are not saved.
 Only	Screen	Top-Left	Position,	Screen	Size,	and	Frame	Layout	are	saved.
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●Setting the background/frames 1-4 
Set	content,	order	of	play	and	duration	for	content	in	the	background	and	frames	1-4.

“Content	Folder”	tree

“Content	File”	list
Playlist

1. Click any of the [Background] or [Frame1] – [Frame4] 
tabs.

2. From the “Content Folder” tree, select the folder where 
the content files you want to use are located.
Confirm	that	the	[Content]	tab	is	selected.	If	the	tab	is	not	
selected, click on it.

You	can	also	display	content	by	specifying	“URL”	or	“Viewer	Path”.
 The [URL] tab

Displays	the	HTML	of	a	specified	URL	as	content.
Enter	a	URL	that	can	be	referenced	by	the	target	PC.
If	your	PC	can	connect	to	the	Internet,	clicking	[View	URL]	will	connect	to	
the	URL	you	have	entered.	Check	that	you	have	connected	properly	and	
that	the	URL	has	been	displayed	correctly.
If	the	URL	is	incorrect,	a	dialog	box	like	the	one	on	the	right	will	appear.

	 •	Use	discretion	when	displaying	URLs	as	websites	are	subject	to	copyright.
 •	If	the	page	you	want	to	display	contains	errors	it	will	not	be	displayed	correctly.
 •	If	the	page	that	you	want	to	display	requires	a	plug-in	the	target	PC	must	have	the	plug-in	installed.
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 [Viewer Path] tab
Displays	the	content	file	specified	with	“File	Path	On	Viewer	PC.”	You	
can	specify	an	EXE	file.	Enter	a	path	that	can	be	referenced	by	the	
target	PC.	For	an	EXE	file,	“Parameters”	can	be	added.

	 •	When	displaying	large	content	files	that	are	not	frequently	updated,	save	the	files	on	the	target	PC	
in advance, and only enter the paths that refer to them. This will help reduce the time it takes to 
send program contents.

 •	Specify	the	absolute	path	of	the	target	PC	or	the	relative	path	from	My	Contents	folder	(Fp.100).
 •	The	following	parameters	can	be	used:

 	 %L	:		X	coordinate	of	top	left	corner	of	frame
 	 %T	:	 Y	coordinate	of	top	left	corner	of	frame
  %W : Width of frame
  %H : Height of frame

 •	This	software	only	launches	or	closes	specified	executable	files	at	a	specified	time.	It	does	not	
guarantee	the	actions	of	any	executable	files	it	launches.	

 •	Depending	on	the	specifications	of	the	file	that	is	executed,	it	may	not	be	able	to	launch	or	close	
correctly, or it may not be able to display windows in the correct position. 

3. Select the content you want to use from the “Content 
File” list.
Refer	to	p.30	for	a	list	of	file	types	that	can	be	used	with	the	
background	and	frames	1-4.

	 •	Click	while	holding	down	[Ctrl]	or	[Shift]	to	select	
multiple	content	files	at	the	same	time.

 •	You	can	preview	content	files	in	the	[Content	
Preview]	window.	(Fp.36)

 •	If	using	HTML	content,	make	sure	that	images,	
movies	and	other	files	referred	to	in	the	HTML	

 	 code	are	transferred	to	the	same	location,	or	a	subdirectory	of	the	same	location,	where	the	HTML	
file	itself	is	stored	(attached	files).	These	can	be	added	from	content	file	properties.	(Fp.37)

 	 Make	sure	that	all	attached	files	are	defined	by	their	relative	paths	in	the	HTML	file.

4. Click .
Content	files	are	added	to	the	end	of	the	playlist.
For	more	details	about	the	playlist	refer	to	p.36.

	 •	In	step	3,	you	can	also	register	content	files	by	
double-clicking them, or dragging them from the 
“Content	File”	list	to	the	“Playlist”.

 •	The	content	files	in	the	playlist	can	be	copied	by	dragging	and	dropping	them	while	holding	down	
the	[Ctrl]	key.

5. Repeat steps 1 to 4 as necessary. You can set the other frames in the same manner.

 By clicking the ( )	button	“add	blank	content”	at	the	bottom	of	the	“Content	File”	list	on	the	
[Frame1]	-	[Frame4]	tabs,	you	can	add	a	hidden	section	to	the	playlist.	Like	other	content	files,	the	
duration and order of play can be set for hidden sections. The frame set in the hidden section is 
not displayed.
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Content preview
You	can	preview	content	files	in	the	[Content	Preview]	window.
Click	[Content	Preview]	from	the	[View]	menu	to	preview	the	files.
Previews	for	the	following	types	of	files	will	not	be	displayed	
immediately.	To	preview	these	files,	click	the	relevant	icon	
displayed	in	the	[Content	Preview]	window.	(Click	the	text	string	if	
previewing a scroll message.) 
•	Files	with	a	size	of	2	MB	or	higher
•	Video	files
•	PowerPoint	files	(Preview	displayed	in	full	screen	mode)
•	Scroll	message	files	(Preview	displayed	in	full	screen	mode)

Playlists
Playlist	content	is	played	in	order	starting	with	the	content	file	at	the	top	of	the	list.
“Duration”	displays	the	length	of	time	taken	to	play	a	particular	content	file.
“Total	Duration”	displays	the	length	of	time	taken	to	play	the	entire	contents	of	the	playlist.
There	are	cases	where	the	total	duration	is	different	from	the	actual	duration	(for	example,	when	“Play	Next	
Content”	is	set	in	the	play	setting,	or	when	using	conditional	content)

Clicking	the	buttons	on	the	top	right	of	a	playlist	performs	the	following	actions:

Icon Menu option Description
Show the properties of the 
content

Displays	the	properties	of	the	currently	selected	content	file.	For	more	
details,	refer	to	p.37.

Move the content to upwards
Moves	the	selected	content	file	one	place	forward	(up)	in	the	list.
(Cannot	move	multiple	content	files.)

Move the content to 
downwards

Moves	the	selected	content	file	one	place	backward	(down)	in	the	list.
(Cannot	move	multiple	content	files.)

Delete the content
Deletes	the	selected	content	files	from	the	list.
Content	files	may	also	be	deleted	by	pressing	[Delete].
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Background color when content is not displayed
When	content	is	not	being	played,	frames	can	be	filled	in	using	a	
specified	color.
Click	the	color	swatch	to	display	the	[Color]	dialog	box	and	
change the background color.

Properties of content
From	the	playlist,	select	a	content	file,	and	click	 	to	display	the	[Properties	of	Content]	dialog	box.
The	following	settings	may	be	adjusted:

1) Content File Path
Displays	the	path	to	the	content	file.
•	Clicking	[Attached	Files]	will	allow	you	to	add	a	file	or	files	
from	the	[Attached	Files]	dialog	box	which	appears.	

•	Clicking	[Change]	will	allow	you	to	change	the	file	via	the	
[Open]	dialog	box	that	appears.

	 If	using	HTML	content,	make	sure	that	images,	movies	
and	other	files	referred	to	in	the	HTML	code	are	
transferred to the same location, or a subdirectory of the 
same	location,	where	the	HTML	file	itself	is	stored.	Make	
sure	that	all	attached	files	referenced	in	the	HTML	file	are	
defined	by	their	relative	paths.

2) Duration
The duration of play can be set.
•	When	the	content	type	is	video,	audio,	or	scroll	message,	you	

can set the operation to be performed when playback of the 
content	is	finished	before	the	specified	duration	is	reached.	
To	set	this,	click	[Play	Setting].

•	When	the	“Scroll	to	the	end	of	this	message”	check	box	is	cleared,	playback	of	scroll	messages	is	forcibly	
terminated	after	the	specified	duration	is	reached	even	if	playback	is	not	finished	yet	(effective	when	the	
content type is scroll message).

•	If	the	same	content	files	are	placed	in	the	playlist	successively,	play	is	resumed	after	returning	to	the	top	of	
the	content	files	after	the	play	time	has	expired.

3)  Background
If	the	content	is	a	still	image	file	and	you	have	checked	the	“Keeping	aspect	ratio”	option	button,	you	can	
specify a background color for the content.
Click	the	color	swatch	to	display	the	[Color]	dialog	box	and	change	the	background	color.
Click	the	box	next	to	“Transparent”	to	make	the	background	transparent.

 The background color for the background frame cannot be set to transparent.

4) Volume Control
The volume can be set.
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5) Layout
•	“Keeping	aspect	ratio”,	“Not	keeping	aspect	ratio”,	and	“In	original	size”	option	buttons
	 You	can	select	“Not	keeping	aspect	ratio”	when	the	content	type	is	a	still	image	or	Flash.
	 You	can	select	“In	original	size”	when	the	content	type	is	a	still	image.
•	“Temporarily,	move	frame”	check	box
	 To	change	the	screen	position	of	the	content	temporarily,	check	this	check	box	and	click	[Position	Setting].	
The	position	and	size	of	the	frame	can	be	specified	for	each	content.	The	screen	position	must	be	set	within	
the background frame.

6) Picture Transition
When the content type is still image, the effect at screen switching can be set.
Select the effect from each pull-down menu.
If	you	check	the	“Via	background”	check	box,	the	effect	of	displaying	the	background	color	at	the	time	of	
screen switching is added.

7) Parameters (for EXE file)
Displays	parameters	for	EXE	files.

●Setting the scroll message
Set scroll message content, order of play and duration of play.
A	scroll	message	file	containing	text	to	be	displayed	in	the	scroll	message	must	be	prepared	in	advance.	For	
details	about	how	to	create	a	scroll	message	file,	refer	to	p.40.
1. Click the [Message1] or [Message2] tab.

2. From the “Content Folder” tree, select the folder where 
the scroll message file you want to use is located.
Confirm	that	the	[Message]	tab	is	selected.	If	the	tab	is	not	
selected, click on it.

	 •	You	can	also	display	the	content	file	specified	with	
“File	Path	On	Viewer	PC”	on	the	[Viewer	Path]	tab.	
Specify	the	absolute	path	of	the	target	PC	or	the	
relative	path	of	the	My	Contents	folder	(Fp.100).

3. Select the scroll message file you want to use from the 
“Content File” list.
Only	scroll	message	files	(.tlp)	and	conditional	content	for	
scroll	message	files	(.dct)	can	be	used	with	Message1	and	
Message2.

	 •	Click	while	holding	down	[Ctrl]	or	[Shift]	to	select	
multiple	scroll	message	files	at	the	same	time.

 •	You	can	preview	scroll	message	files.	Scroll	
message	file	previews	are	available	in	full	screen	
mode only. (Fp.36)
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Clicking	the	buttons	at	the	bottom	of	the	“Content	File”	list	performs	the	following	actions:

Icon Menu option Description
Create	New	Scroll	
Message

Launches	Scroll	Message	Editor	and	allows	you	to	create	new	scroll	
messages.

Edit	Scroll	Message
Launches	Scroll	Message	Editor	and	allows	you	to	edit	the	scroll	
message	selected	in	the	“Content	File”	list.

Delete Scroll Message Deletes	the	scroll	messages	selected	in	the	“Content	File”	list.

add blank scroll 
message

A	hidden	section	can	be	added	to	the	playlist.	Like	other	content	files,	
the duration and order of play can be set for hidden sections.

For	more	details	about	Scroll	Message	Editor,	refer	to	p.40.
4. Click .

Scroll	message	files	are	added	to	the	end	of	the	playlist.	
For	more	details	about	the	playlist,	refer	to	p.36.

	 In	step	3,	you	can	also	register	scroll	message	files	
by double-clicking them, or dragging them from the 
“Content	File”	list	to	the	“Playlist”.

5. Repeat steps 1 to 4 as necessary. You can set other scroll messages in the same manner.
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Creating scroll message files
Create	a	message	to	be	displayed	in	a	scroll	message.
1. Click the [Message1] or [Message2] tab, and then click  under the “Content File” list.

Scroll	Message	Editor	will	launch.

1) Title bar
A	file	name	will	be	displayed.
When	Scroll	Message	Editor	launches,	the	title	bar	will	read	“Untitled”.	When	a	file	is	saved,	it	will	change	to	
the	name	of	the	file.	When	content	of	an	opened	file	is	changed,	the	title	bar	will	display	an	asterisk	(*)	after	
the	file	name.

1)	Title	bar

2)	Menus

3) Toolbar

4)	Settings	window
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2) Menus
Menu options are as follows:

Menu option Description

File

Create	New	Scroll
Message

Opens	a	new	scroll	message	file.

Open Scroll Message Loads	a	saved	scroll	message	file.

Save Scroll Message Overwrites	the	currently	edited	scroll	message	file.
Save Scroll Message As Saves	the	currently	edited	scroll	message	file	under	a	different	name.
Exit Exits	Scroll	Message	Editor.

Edit

Cut Cuts	the	text	string	selected	in	the	“Scroll	message	edit	box”.
Copy Copies	the	text	string	selected	in	the	“Scroll	message	edit	box”.

Paste
Pastes	a	text	string	that	has	been	cut	or	copied	into	the	“Scroll	
message	edit	box”.

Undo Undoes	the	last	action	performed	in	the	“Scroll	message	edit	box”.

View Preview Scroll Message

Displays	a	preview	of	the	currently	edited	scroll	message	file.
Press	[Esc]	to	close	the	preview.	If	a	window	other	than	the	window	
for scroll messages is clicked during the preview, it cannot be 
terminated	even	if	the	[Esc]	key	is	pressed.	Click	the	preview	once	
and	then	click	the	[Esc]	key.

Help
About Scroll Message 
Editor

Displays	version	information	for	Scroll	Message	Editor.

3) Toolbar
The toolbar buttons (icons) perform the following actions:

Icon Menu option Description

Open Scroll Message Loads	a	saved	scroll	message	file.

Save Scroll Message Overwrites	the	currently	edited	scroll	message	file.

Preview Scroll Message

Displays	a	preview	of	the	currently	edited	scroll	message	file.
Press	[Esc]	to	close	the	preview.	If	a	window	other	than	the	window	for	
scroll messages is clicked during the preview, it cannot be terminated 
even	if	the	[Esc]	key	is	pressed.	Click	the	preview	once	and	then	click	
the	[Esc]	key.

About Scroll Message 
Editor

Displays	version	information	for	Scroll	Message	Editor.

4) Settings window
For	more	details,	continue	reading	from	step	2.

2. Enter a text string that you want to use in a scroll 
message into the “Scroll message edit box”.
The	longer	the	text	string	is,	the	more	memory	will	be	used.	
We recommend starting a new line at a suitable interval so 
that lines do not get too long.

Creating programs

Download from Www.Somanuals.com. All Manuals Search And Download.



42

Program Editor

Checking	the	[Use	HTML	tag]	check	box	allows	you	to	use	
the	following	HTML	tags	in	the	“Scroll	message	edit	box”	to	
define	the	font	color,	size	and	other	styles.

Tag Explanation

<FONT>
Defines	the	text.	Takes	the	COLOR,	SIZE	and	FACE	attributes	which	respectively	define	the	
text	color,	text	size	and	typeface.

<B> Defines	bold	text.
<I> Defines	italic	text.
<U> Defines	underlined	text.
<S> Defines	strikethrough	text.
<BIG> Defines	bigger	text.
<SMALL> Defines	smaller	text.

3. Set the “Message Format”.
Set	the	display	direction	of	text,	font	and	text	color.
1)	Next	to	“Orientation”,	select	the	display	direction	of	text.

2)	 To	change	the	font,	click	[Select	Font]	and	choose	a	font	
from	the	[Font]	dialog	box.

	 •	You	must	have	the	same	font	installed	on	the	target	PC.
 •	Depending	on	the	type	of	font	used,	text	size	may	not	be	acquired	correctly	resulting	in	scrolling	

being interrupted.

3)	Set	the	“Text	Color.”
	 In	the	[Color]	dialog	box	that	appears	when	clicking	the	rectangle	in	which	a	color	is	displayed,	the	color	

can be changed.

4)	Select	“Decoration”	from	the	“None,”	“Bordering,”	or	“Shadowing”	option	button.
	 If	“Bordering”	or	“Shadowing”	is	selected,	the	text	color	can	be	changed	in	the	[Color]	dialog	box	that	

appears	when	clicking	the	rectangle	of	“Decoration	Color”.

4. Set “Background.”
Set the background of scroll messages.
1)	Set	“Background	Color.”
	 The	color	can	be	changed	in	the	[Color]	dialog	box	that	

appears when clicking the rectangle in which a color is 
displayed.

2)	Checking	the	“Use	Transparent”	check	box	allows	you	to	make	the	background	color	transparent.	
	 Drag	the	“Rate”	slider	to	the	left	or	right	to	set	the	transparency	(10	steps	available).

	 •	Do	not	check	the	check	box	when	you	do	not	want	to	make	the	background	color	transparent.	
Even	if	the	slider	is	set	to	opaque	at	the	right	end,	the	background	does	not	become	completely	
non-transparent.

 •	When	the	check	box	is	checked,	the	color	set	for	the	background	itself	is	made	transparent.	
Therefore,	if	“Text	Color”	and	“Decoration	Color”	are	the	same	as	“Background	Color,”	“Text	Color”	
and	“Decoration	Color”	are	also	made	transparent.

 •	If	transparent/semi-transparent	scroll	messages	are	located	on	a	video,	the	desired	effect	may	not	
be obtained.
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5. Set “Scrolling.”
Set the scroll direction and speed of scroll messages.
1)	Select	the	“Direction”	from	“Leftward,”	“Rightward,”	

“Upward”	and	“No	Move”	option	buttons.

	 •	If	the	“Vertical”	option	button	is	selected	in	
“Message	Format,”	the	“Leftward”	or	“Rightward”	
option button cannot be selected.

 •	If	“No	Move”	is	selected,	scroll	messages	are	displayed	at	the	center	of	the	specified	range	line	by	
line. (The portion that is outside of this range is not displayed.)

2)	Drag	the	“Speed”	slider	to	the	left	or	right	to	set	the	scroll	speed	(10	steps	available).

	 •	Even	if	the	scroll	message	speed	is	set	at	the	same	value,	the	actual	scroll	speed	may	differ	
depending	on	the	performance	of	the	PC.

 •	When	the	“Use	Transparent”	check	box	is	checked,	the	scroll	speed	may	be	lower	compared	with	
that	of	opaque	scroll	messages.	It	is	recommended	that	tests	be	conducted	by	actually	displaying	
scroll messages before operation. 

Settings	to	be	made	when	the	“No	Move”	option	button	is	selected	
3)	Set	“Display	Time	of	Each	Line.”	(0	to	9999	seconds)
 Scroll messages are displayed line by line. Set the display time.

4)	Set	whether	to	perform	fade-in	and	fade-out.
	 To	display	scroll	messages	so	that	the	currently	displayed	scroll	message	fades	out	and	the	next	scroll	

message	fades	in	when	switching	between	scroll	messages,	check	the	“Use	Fading	in/out	When	Telop	
Switches.”	check	box.	

 If fade-in/fade-out scroll messages are located on a video, the desired effect may not be obtained.

6. Click [Save Scroll Message] from the [File] menu.
 Or click . 

The	[Save	As]	dialog	box	will	appear.

7. Enter a new name in “File Name” and click [Save].
The	creation	of	the	scroll	message	file	is	now	complete.
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●Setting audio and music
Set audio and music (background music) for program display.

	 If	two	or	more	content	files	containing	audio	are	set	in	different	frames,	both	will	play.

1. Click the [Sound] tab.

2. From the “Content Folder” tree, select the folder where 
the content files you want to use are located.
Confirm	that	the	[Sound]	tab	is	selected.	If	the	tab	is	not	
selected, click on it.

	 You	can	also	play	back	the	content	file	specified	
with	“File	Path	On	Viewer	PC”	on	the	[Viewer	Path]	
tab.	Specify	the	absolute	path	of	the	target	PC	or	
the	relative	path	of	the	My	Contents	folder	(Fp.91).

3. Select the content you want to use from the “Content 
File” list.
For	a	list	of	compatible	audio	file	types,	refer	to	p.30.

	 •	Click	while	holding	down	[Ctrl]	or	[Shift]	to	select	
multiple	content	files	at	the	same	time.

 •	Audio	cannot	be	positioned	in	a	layout.	If	you	
select	a	movie	for	the	content	file	that	will	be	used	
as audio, a movie preview will be displayed in the 
[Content	Preview]	window,	but	only	audio	will	be	
used when the program is actually displayed.

 •	Clicking	the	“add	no	sound	portion”	button	( )	at	the	bottom	of	the	“Content	File”	list	will	allow	
you to add a soundless portion to the playlist. Settings for duration and order of play can be set for 
soundless	portions	in	the	same	way	as	for	other	content	files.

4. Click .
Content	files	are	added	to	the	end	of	the	playlist.
For	more	details	about	the	playlist,	refer	to	p.36.

	 In	step	3,	you	can	also	register	content	files	by	double-clicking	them,	or	dragging	them	from	the	
“Content	File”	list	to	the	“Playlist”.
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●Setting the PIP window
Set	the	frame	size,	aspect	ratio,	input	source,	and	audio	source	for	the	PIP	frame.	This	function	can	be	used	
only	with	the	SHARP	LCD	monitor	(PN	series).

1. Click the [PinP] tab.

2. Select the “Monitor Model Name”.

3. Set values for each item.
A	list	will	appear	when	you	click	on	a	cell	in	the	“Value”	
column.
If using a PN-655 monitor
*		Items	displayed	vary	according	to	the	“Monitor	Model	
Name”.

1)	Select	“Size”.
	 Monitor	sizes	vary	according	to	aspect	ratio.
2)	Select	either	“16:9”	or	“4:3”	from	the	“Aspect	Ratio”	list.

*  Select this according to the video or images that you 
want to display.

3)	Select	“D-Terminal”,	“Composite	(Video)”,	or	
“Component”	for	the	“Input	Source”	option.

4)	Select	either	“PC”	or	“AV”	for	“Sound	Source”.
5)	 “Direction”	can	only	be	set	to	“Landscape”.
*		The	video	signal	may	cause	misalignment	with	PIP	location	and	size.

●Saving a program

Save program
Use	this	option	when	you	want	to	save	the	currently	edited	program	under	its	original	name.
1. From the [File] menu, click [Save Program]. 

You can also save by clicking .
A	confirmation	message	for	creating	a	thumbnail	will	appear.

	 When	“Program	Editor”	is	started,	the	title	bar	will	read	“Untitled”.	If	you	attempt	to	save	at	this	
stage	the	[Save	Program]	dialog	box	will	be	displayed.	For	the	remaining	steps,	please	refer	to	
step	2	of	“Save	program	as”.

2. When you want to create a thumbnail, click [Yes]. When you do not 
want to create a thumbnail, click [No].
When	you	click	[Yes],	a	small	program	preview	for	creating	a	thumbnail	
will appear. Do not perform any operation before this preview screen 
disappears.
For	more	details	about	the	program	thumbnail,	refer	to	p.46.

 If you have already created a thumbnail, the program thumbnail is not deleted even if you click 
[No].	The	previous	thumbnail	is	displayed.
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Save program as
Use	this	option	when	you	want	to	save	the	currently	edited	program	under	a	different	name.
1. From the [File] menu, click [Save Program As].

The	[Save	Program	As]	dialog	box	will	appear.
2. Select the program folder in which the program is to be 

saved.
For	more	details	about	the	program	folder,	see	the	following.

3. Enter a new name in “Program Name” and click [Save].
A	confirmation	message	for	creating	a	thumbnail	will	appear.

4. When you want to create a thumbnail, click [Yes].  
When you do not want to create a thumbnail, click [No].
When	you	click	[Yes],	a	small	program	preview	for	creating	a	thumbnail	
will appear. Do not perform any operation before this preview screen 
disappears.
For	more	details	about	the	program	thumbnail,	see	the	following.

 If you have already created a thumbnail, the program thumbnail is not deleted even if you click 
[No].	The	previous	thumbnail	is	displayed.

Program thumbnails
When a program thumbnail is created, it is displayed in the 
[Open	Program],	[Save	Program	As],	[Delete	Program],	[Import	
Program],	and	[Export	Program]	dialog	boxes	and	the	[Program]	
tab of the timetable editor. 

	 •	There	are	cases	in	which	a	video	is	not	displayed.
 •	If	the	PIP	function	is	used,	the	PIP	portion	is	not	

displayed.

Program Folder
•	Programs	can	be	saved	in	different	program	folders	according	

to the type of program.
•	The	programs	in	the	selected	program	folder	are	displayed	in	
“Program	List	of	Selected	Program	Folder.”

•	In the menu that appears when right-clicking the program storage folder, the following operation can be performed.
•	Insert:		 	Adds a new program folder under the selected folder. 
	 	 	Enter	a	new	name	in	the	[Program	Folder	Name]	

dialog	box	and	click	[OK].
•	Delete:		 	Deletes	the	selected	folder.	If	the	selected	folder	

contains a program, it cannot be deleted.
•	Rename:			Changes	the	name	of	the	selected	folder.	Enter	a	new	name	in	the	[Program	Folder	Name]	dialog	

box	and	click	[OK].

	 •	The	“Programs”	folder	in	the	first	level	cannot	be	deleted	or	renamed.	
 •	If	the	selected	folder	contains	a	program,	it	cannot	be	deleted.

•	By	dragging	and	dropping	the	folder,	the	location	of	the	folder	can	be	changed.
•	By	dragging	and	dropping	a	program	in	“Program	List	of	Selected	Program	Folder”	to	another	folder,	the	

program can be moved.
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●Opening a program
Load	a	program	that	you	have	already	saved	and	use	it.
Editing	only	the	places	you	want	to	change	in	an	existing	file	and	saving	the	file	under	a	new	name	is	an	
effective way to create programs.
1. From the [File] menu, click [Open Program]. 

You can also open a program by clicking .
The	[Open	Program]	dialog	box	will	appear.

2. Select the program folder containing the program.

3. From the “Program List”, select a program, and click 
[Open].
The	program	you	selected	will	be	loaded	into	Program	Editor	
and you will be able to edit it.

	 Take	care	when	saving	the	program	you	have	edited	using	the	[Save	Program]	option,	as	the	
changes	you	have	made	will	be	reflected	in	the	original	file.

●Checking a program
Check	a	program	using	the	program	preview	function.
Two previews with the same data will be displayed.
1. If you want to preview a program at its original size, click 

[Preview Program [Original size]] from the [View] menu. 
You can also preview a program by clicking .
A preview of the currently edited program will be displayed at 
its	original	size.

	 •	Previews	can	also	be	displayed	by	pressing	[F5].
 •	If	you	want	to	use	the	program	preview	function	on	

a	more	detailed	setting,	check	“Set	Configuration	
before	Preview	Program”	on	the	[View]	menu.

 •	This	enables	you	to	set	specific	dates	and	
times,	specific	panel	displays	and	other	program	
conditions and display previews.

 If you want to preview a program at screen size, click [Preview Program [Fit screen]] from the [View] 
menu. 
You can also preview a program at screen size by clicking .
A	preview	of	the	currently	edited	program	fitted	to	the	size	of	the	screen	will	be	displayed.

2. Check the preview.
PowerPoint and scroll messages will be displayed in the foreground, regardless of display priority order.
Set PowerPoint data so that it plays repetitively by setting slide transition to advance slides automatically 
(automatic slideshow).
Do not use the mouse or keyboard (e.g. to click on a window etc.) during program display. Doing so may 
change the window display order or alter the content to be played.

	 •	To	close	the	preview,	click	the	preview	window	and	press	[Esc].
 •	If	the	program	screen	size	is	larger	than	the	display	resolution	of	the	monitor,	the	preview	cannot	

be displayed in full screen mode.
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●Preview Program Display Settings
If	you	check	“Set	Configuration	before	Preview	Program”	on	the	
[View]	menu,	the	“Preview	program	setting”	screen	(*a	screen	
image displayed on the screen) will be displayed during the 
program	preview.	You	can	set	the	following	conditions,	and	if	
you	click	the	“Preview”	button,	the	preview	will	occur	under	the	
conditions you have set.
•	Preview	this	program	after	a	set	amount	of	time	has	passed:
	 Displays	the	program	preview	after	a	specified	amount	of	time	
has	passed.	The	very	first	content	to	be	played	will	play	from	
the	beginning	of	that	content,	starting	at	the	specified	time	and	
playing for the amount of time set on the Playlist. There are 
cases	where	the	very	first	content	to	be	played	will	end	abruptly,	
and	the	preview	will	continue	on	to	the	next	content.

•	Preview	this	program	after	setting	reference	conditions	for	conditional	content:
	 Click	“Play	Condition	Setting”	to	set	conditions
•	“Play	date”	 :	 	Sets the date on which the program will be played.
•	“Play	Time”	 :	 	Sets the time at which the program will be played.
•	“Panel	name”	 :	 	Sets the panel on which the program will be played.
•	“Group”	 :	 	Sets the group with which the program will be played.
•	“Comment”	 :	 	Sets comments on the panel on which the program will be played.

•	Display	this	program	preview	over	the	edges	of	multiple	monitors:
 Displays the program preview over the edges between panels when using multiple monitors
 * Think of the edges as rough estimates.
•	“Model	name”	 :	 	Select the monitor model name.
•	“Composition”	 :	 	Select the multi-monitor setup.

●Deleting a program
Delete unnecessary programs.
1. Click [Delete Program] from the [File] menu.

The	[Delete	Program]	dialog	box	will	appear.
2. Select the program folder containing the program.
3. Select a program from the “Program List” and click 

[Delete].

4. Click [Yes].
The selected program has now been deleted.

5. Click [Close].
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●Displaying program properties
Change	program	names	and	program	colors.
1. Click [Properties of Program] from the [File] menu. 

You can also display and change program properties by clicking .
The	[Properties	of	Program]	dialog	box	will	appear.

Information	about	the	“Program	Name”,	“Duration”,	“Color	of	
Program”,	“Option”,	and	“Data	Path”	is	displayed.
•	 The	“Program	Name”	can	be	changed.	
•	 Click	the	color	swatch	to	display	the	[Color]	dialog	box	

and change the program color.
•	 If	you	check	the	“The	layout	edit	is	locked.”	check	box,	

layout	editing	is	disabled.	Check	this	check	box	when	
you want to prevent the layout from being changed due 
to	a	mistake	during	the	operation	of	Program	Editor.

	 The	“Color	of	Program”	is	the	color	used	to	display	
the	program	in	the	Timetable	Editor.

2. Click [OK].

	 “Duration”	may	be	different	from	the	actual	duration.
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●Importing/exporting a program

Exporting a program
The	export	function	is	used	to	write	out	a	program	so	that	it	can	be	used	with	this	product	on	another	PC.

1. From the [File] menu, click [Export Program].
The	[Export	Program]	dialog	box	will	appear.

2. Select the program folder containing the program.

3. From the “Program List”, select a program, and click 
[Export].
The	[Select	the	folder	to	export]	dialog	box	will	appear.

4. Specify the directory where you want to save the file, 
enter a “File name”, and click [Save].
The	[Export	Program]	dialog	box	will	appear.

 A screen like the one on the right will appear during 
the	export.	Click	[Cancel]	to	cancel	the	export.

5. Click [OK].
The	program	export	is	now	complete.
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Importing a program
The	import	function	is	used	to	load	an	exported	program	that	has	been	created	with	this	product	on	another	PC.
1. From the [File] menu, click [Import Program].

The	[Select	the	program	to	import]	dialog	box	will	appear.

2. Select a (.prg) file to import, and click [Open].
The	[Import	Program]	dialog	box	will	appear.

 A screen like the one on the right will appear while 
the	import	is	being	prepared.	Click	[Cancel]	to	
cancel the import.

3. Select the program folder in which the program is to be 
saved.

4. Enter a “Program Name”, and click [Import].

5. Click [Yes].
The program will be saved with the name you entered.
The program import is now complete.
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Conditional Content
When creating Playlists with the program editor, most of the content is the same, and in many cases, multiple 
Playlists with only one differing part are created. In these cases, you can display Playlists with only the differing 
part	changed	according	to	specified	conditions	when	using	conditional	content.

Basic Screens for SHARP Digital Signage Software Conditional Content Editor

●Launching SHARP Digital Signage Software Conditional Content Editor
1. Click the [Start] button on the Windows Taskbar, and then click “All Programs” – “SHARP Digital 

Signage Software” – “Tools” – “Conditional Content Editor” in order.
This	will	launch	“Conditional	Content	Editor.”

●Basic Screens for SHARP Digital Signage Software Conditional Content Editor

1) Title bar
Displays	the	file	name.	When	Editor	launches,	the	title	bar	will	read	“Untitled.”	When	a	file	is	saved,	it	will	change	
to	the	name	of	the	file.
When	content	of	an	opened	file	is	changed,	the	title	bar	will	display	an	asterisk	(*)	after	the	file	name.
*		You	can	register	and	edit	Playlists	by	selecting	“Replace	to	Conditional	Content”	from	the	program	editor	

Playlist.

1)	Title	bar

2)	Menus

3) Toolbar

4)	Tabs

5)	Settings	Window
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2) Menus
The	following	are	the	contents	of	the	[File],	[View],	and	[Help]	menus.

Menu option Description

File

Create	New	Conditional	
Content

Opens	a	new	file.

Open	Conditional	Content Reads saved conditional content.

Save	Conditional	Content Saves the currently edited conditional content.
Save	Conditional	Content	
As

Saves the currently edited conditional content under a different name.

Exit Quits	Conditional	Content	Editor.

View

Show	Content	Preview	
window

Displays a preview of the currently edited conditional content in a 
window	the	size	of	the	preview	window.

Refresh
Updates	content	from	the	content	folders	in	the	event	that	content	
files	have	been	added	to	or	deleted	from	the	Conditional	Content	
Folder	since	SHARP	Digital	Signage	Software	was	launched.

Help
About	Conditional	Content	
Editor

Displays	version	information	for	Conditional	Content	Editor.

3) Toolbar
The function of each button (icon) is as follows.

Icon Menu option Description

Create	New	Conditional	
Content	for	Background/
Frames

Creates	new	conditional	content	for	background/frames.

Create	New	Conditional	
Content	for	Messages

Creates	new	conditional	content	for	scroll	messages.

Create	New	Conditional	
Content	for	Sound

Creates	new	conditional	content	for	sound.

Open	Conditional	
Content

Reads saved conditional content.

Save	Conditional	
Content

Saves conditional content.

4) Tabs
When	you	click	any	of	the	[Content],	[URL]	or	[Viewer	Path]	tabs,	you	will	go	to	the	setting	window	for	that	
tab.

5) Settings Window
Set details for the tab that you selected.
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Creating Conditional Content

●Compatible Content File Formats
The	following	file	formats	can	be	used	as	content.

Types of Conditional 
Content Compatible File Extensions

Background,	Frame
.jpg,	.jpeg,	.gif,	.png,	.bmp,	.avi,	.mpeg,	.mpg,	.wmv,	.asf,	.mov,	.swf,	.ppt,
.pps,	.htm,	.html,	.exe

Scroll Messages .tlp
Audio .wav, .mp3, .au, .aif, .aiff, .wma, .mid, .midi, .mov

●Configuring Conditional Contents
Set	project	names,	playback	start	dates,	and	Target	PC	panel	attributes	for	conditional	content.

Content	Folder	tree

Content	File	List

Condition	List

Play	Condition
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1. From the “Content Folder” tree, Select the folder where the content files you want to use are 
located.

 The [URL] Tab
Displays	the	HTML	of	a	specified	URL	as	content.
Enter	a	URL	that	can	be	referenced	by	the	Target	PC.
If	your	PC	can	connect	to	the	Internet,	clicking	[View	URL]	will	
connect	to	the	URL	you	have	entered.
Check	that	you	have	connected	properly	and	that	the	URL	
has been displayed correctly.
If	the	URL	is	incorrect,	a	dialog	box	like	the	one	on	the	right	
will appear.

 [Viewer Path] Tab
Displays	the	content	file	specified	with	[File	Path	On	Viewer	PC].	You	can	specify	an	EXE	file.	Enter	a	path	
that	can	be	referenced	by	the	target	PC.	For	an	EXE	file,	“Parameters”	can	be	added.

	 •	When	displaying	large	content	files	that	are	not	frequently	updated,	save	the	files	on	the	target	PC	
in advance and only enter the paths that refer to them. This will help reduce the time it takes to send 
program contents.

 •	Specify	the	absolute	path	of	the	target	PC	or	the	relative	path	from	My	Contents	Folder	(refer	to	p.	100).
 •	The	following	parameters	can	be	used.
 	 	 %L	 :	 X	coordinate	of	top	left	corner	of	frame
 	 	 %T	 :	 Y	coordinate	of	top	left	corner	of	frame
   %W : Width of frame
   %H : Height of frame
 •	This	software	only	launches	or	closes	specified	executable	files	at	a	specified	time.	It	does	not	guarantee	

the	actions	of	any	executable	files	it	launches.
 •	Depending	on	the	specifications	of	the	file	that	is	executed,	it	may	not	be	able	to	launch	or	close	

correctly, or it may not be able to display windows in the correct position.

2. Select the content files you want to use from the Content 
File List.
Refer	to	Page	54	for	file	formats	compatible	with	backgrounds	
and frames.

	 •	You	can	check	content	file	previews	in	the	[Show	
Content	Preview	Window]	window.	(refer	to	p.	56)

 •	If	using	HTML	content,	make	sure	that	images,	
movies	and	other	files	referred	to	in	the	HTML	
code are transferred to the same location, or a 
subdirectory	of	the	same	location,	where	the	HTML	
file	itself	is	stored	(attached	files).

	 	 These	can	be	added	from	content	file	properties.	
(refer	to	p.	57)

	 	 Make	sure	that	all	attached	files	are	defined	by	their	
relative	paths	in	the	HTML	file.
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3. Click the  icon.
Content	files	are	added	to	the	end	of	the	condition	list.
For	more	details	about	the	condition	list,	refer	to	Page	59.

	 •	In	Step	3,	you	can	register	content	files	by	double-
clicking	them	or	by	dragging	them	from	the	Content	
File	list	to	the	[condition	list].

 •	The	content	files	from	the	conditions	list	can	be	copied	by	dropping	and	dragging	them	while	
holding	the	[Ctrl]	key.

 Preview Content
You	can	preview	content	files	in	the	[Show	Content	Preview	
Window]	window.
Click	[Show	Content	Preview	Window]	from	the	[View]	menu	
to	preview	the	files.
Previews	from	the	following	types	of	files	will	not	be	displayed	
immediately.	To	preview	these	files,	click	the	relevant	icon	
displayed	in	the	[Show	Content	Preview	Window]	window.	
(Click	the	text	string	if	previewing	a	scroll	message.)
•	Files	with	a	size	of	2	MB	or	higher
•	Video	files
•	PowerPoint	files	(Preview	displayed	in	full	screen	mode)
•	Scroll	message	files	(Preview	displayed	in	full	screen	mode)

	 •	Set	PowerPoint	data	so	that	it	plays	repetitively	
by setting slide transition to advance slides 
automatically (automatic slideshow).

 •	Do	not	use	the	mouse	or	keyboard	(e.g.	to	click	on	a	window	etc.)	during	program	display.	Doing	
so may change the window display order or alter the content to be played.

 Conditional Content
Content	conditions	are	checked	and	only	the	first	content	that	matches	those	conditions	is	displayed.	The	list	
plays in order starting from the top, and contents that do not match conditions are skipped.
The duration is the amount of time it takes to play content.
Content	files	on	the	playlist	with	the	longest	durations	are	displayed	on	the	Maximum	Duration	List.
There	are	cases	where	the	maximum	duration	is	different	from	the	actual	duration	(for	example,	when	“Play	
Next	content”	is	set	in	the	“play	setting”)
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Clicking	the	buttons	on	the	top	right	of	a	playlist	performs	the	following	actions:

Icon Menu option Description
Show the properties of the 
content

Displays	the	properties	of	the	currently	selected	content	file.
See below for more details.

Set content playback 
conditions

Sets playback conditions for selected content.
For	more	details,	refer	to	Page	59.

Move content upward
Moves	the	selected	content	file	one	place	forward	(up)	on	the	list.
(You	cannot	move	multiple	content	files.)

Move content downward
Moves	the	selected	content	file	one	place	backward	(down)	on	the	list.
(You	cannot	move	multiple	content	files.)

Delete content
Deletes	the	selected	content	files	from	the	conditions	list.
You	can	delete	content	files	by	pressing	the	[Delete]	key.

 Properties of content
From	the	playlist,	select	a	content	file,	and	click	 	to	display	the	[Properties	of	Content]	dialog	box.
The	following	settings	may	be	checked	and	adjusted:

1) Content File Path
Displays	the	path	to	the	content	file.
•		Clicking	[Attached	Files]	will	allow	you	to	add	a	file	or	files	
from	the	[Attached	Files]	dialog	box	that	appears.
•		Clicking	[Change]	will	allow	you	to	change	the	file	via	the	
[Open]	dialog	box	that	appears.

	 If	using	HTML	content,	make	sure	that	images,	
movies	and	other	files	referred	to	in	the	HTML	
code are transferred to the same location, or a 
subdirectory	of	the	same	location,	where	the	HTML	
file	itself	is	stored.	Make	sure	that	all	attached	files	
referenced	in	the	HTML	file	are	defined	by	their	
relative paths.

2) Duration
The duration of play can be set.
•		When	the	content	type	is	video,	audio,	or	scroll	message,	you	can	set	the	operation	to	be	performed	
when	playback	of	the	content	is	finished	before	the	specified	duration	is	reached.	To	set	this,	click	[play	
setting].
•		When	the	“Scroll	to	the	end	of	this	message”	check	box	is	cleared,	playback	of	scroll	message	is	forcibly	
terminated	after	the	specified	duration	is	reached	even	if	playback	is	not	finished	yet	(effective	when	the	
content type is scroll message).
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3) Background
If	the	content	is	a	still	image	file	and	you	have	checked	the	“Keeping	aspect	ratio”	option	button,	you	can	
specify a background color for the content.
Click	the	color	swatch	to	display	the	[Color]	dialog	box	and	change	the	background	color.
Click	the	box	next	to	“Transparent”	to	make	the	background	transparent.

 The background color for the background frame will be displayed as black if the background color 
is set to transparent.

4) Volume Control
The volume can be set.

5) Layout
•		“Keeping	aspect	ratio”/	“Not	keeping	aspect	ratio”	/	and	“In	original	size”	option	buttons 
You	can	select	“Not	keeping	aspect	ratio”	when	the	content	type	is	a	still	image	or	Flash. 
You	can	select	“In	original	size”	when	the	content	type	is	a	still	image.
•		“Temporarily,move	frame”	check	box 
To	change	the	screen	position	of	the	content	temporarily,	check	this	box	and	click	[Position	Setting].	The	
position	and	size	of	the	frame	can	be	specified	for	each	content.

6) Picture Transition
When the content type is still image, the effect at screen switching can be set.
Select the effect from each pull-down menu.
If	you	check	the	“Via	background”	check	box,	the	effect	of	displaying	the	background	color	at	the	time	of	
screen switching is added.

7) Parameters
Displays	parameters	for	EXE	files.
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 Play Condition Setting
From	the	conditions	list,	select	a	content	file	and	click	 	to	display	the	[Properties	of	Content]	dialog	box.
Select	files	from	the	list	and	right-click	them.	The	display	will	remain	visible	even	when	[Set	Play	Condition]	is	
selected.
The	following	settings	may	be	checked	and	adjusted:
1) Condition Name
You	can	set	the	playback	condition	name

2) Term
You	can	set	the	beginning	and	end	dates.

3) Time
You	can	set	the	beginning	and	end	times.

4) Date
You	can	set	the	playback	date.

5) Day
You	can	set	the	day	of	the	week	for	playback.
You	can	select	multiple	days	of	the	week	(e.g.	Sunday-
Monday).

6) Week
You	can	set	playback	to	occur	on	a	certain	week	of	every	
month.	You	can	select	multiple	weeks	out	of	every	month	
(e.g.	first	and	third	weeks).

7) Panel name
You	can	use	the	[OK]	button	to	set	playback	to	occur	on	the	panels	that	include	the	characters	you	
entered or to play back on the panels that do not include those characters.

8) Group
You	can	use	the	option	button	to	set	playback	to	occur	or	not	to	occur	in	the	groups	that	contain	the	
characters you enter.

9) Comment
You	can	use	the	option	button	to	set	playback	to	occur	on	the	panel	configured	with	the	comment	that	
includes the characters you entered, or to play back on the panels that do not include those characters.

	 •	You	can	hide	content	by	clicking	the	  icon on the bottom left of the screen.
 •	You	can	turn	the	sound	off	by	clicking	the	  icon on the bottom left of the screen.
 •	You	can	skip	conditional	content	and	play	the	next	playlist	by	clicking	the	  on the bottom left of the screen.
 •	By	setting	the	playback	conditions,	the	selected	playback	conditions	will	appear	in	the	frame	below	

the conditions list.

 Conditional Content and Total Duration

Still Image (5 seconds)

Still Image (5 seconds)

Video (20 seconds)

Conditional Content
(10 seconds)

Still Image (5 seconds)

Still Image (5 seconds)

Video (20 seconds)

Monday’ s Content
(10 seconds)

Still Image (5 seconds)

Still Image (5 seconds)

Video (20 seconds)

Tuesday’ s Content
(15 seconds)

Still Image (5 seconds)

Still Image (5 seconds)

Video (20 seconds)

Wednesday’ s Content
(20 seconds)

Still Image (5 seconds)

Still Image (5 seconds)

Video (20 seconds)

Unconditional Content
(10 seconds)

Program Information
(Total Duration: 40 seconds)

The Program Editor will reflect the maximum duration from within the total duration when you close the Conditional Content Editor. 

Monday’ s Content

Tuesday’ s Content

Wednesday’ s Content

Unconditional Content

10 seconds

15 seconds

20 seconds

10 seconds

Monday’ s Program
(Total Duration: 40 seconds)

Tuesday’ s Program
(Total Duration: 45 seconds)

Wednesday’ s Program
(Total Duration: 50 seconds)

Other Programs (Not M-T-W)
(Total Duration: 40 seconds)
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Set	programs	created	with	Program	Editor	to	display	at	a	set	hour	of	the	day.

The main Timetable Editor window

●Launching Timetable Editor
1. Click  on the Launcher window.

“Timetable	Editor”	will	launch.

When	Timetable	Editor	launches,	a	new	blank	timetable	with	no	programs	assigned	will	be	displayed.	
Timetables are completed after program is set on this screen.

	 Timetable	Editor	can	also	be	launched	by	going	to	the	Windows	Taskbar	and	clicking	[Start],	 
[All	Programs],	[SHARP	Digital	Signage	Software],	[Tools],	and	then	[Timetable	Editor].

●The main Timetable Editor window
1)	Title	bar

2)	Menus

3) Toolbar

4)	Tabs

5)	Program/Panel	
Control	list

6)	Timetable

1) Title bar
The name of the timetable will be displayed here.
When	Timetable	Editor	launches,	the	title	bar	will	read	“Untitled”.	When	a	timetable	is	saved,	it	will	change	to	
the name of the timetable. When content of an opened timetable is changed, the title bar will display an asterisk 
(*) after the timetable name.

Creating/Editing a Timetable
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2) Menus
Menu options are as follows:

Menu option Description Relevant 
page

File

Create	New	Timetable Opens a new timetable. -
Open Timetable Loads	a	saved	timetable. Fp.66
Save Timetable Overwrites the currently edited timetable. Fp.65

Save Timetable As
Saves the currently edited timetable under a different 
name.

Fp.66

Delete Timetable Allows the user to specify and delete saved timetables. Fp.67

Preview Timetable

Tests the currently edited timetable. Note that all the 
registered timetable data and schedule data is erased 
in the SHARP Digital Signage Software standalone 
version	(PN-SS01).

Fp.66

Properties of Timetable Displays timetable properties. Fp.67

Import Timetable
Reads	a	timetable	that	has	been	exported	from	another	
PC	so	that	it	can	be	used.

Fp.69

Export	Timetable
Writes out a timetable so that it can be used on another 
PC.

Fp.68

Exit Exits	Timetable	Editor. -

Edit

Select All Selects all programs in the timetable. -

Delete
Deletes the selected programs from the list.
Programs	may	also	be	deleted	by	pressing	[Delete].

-

Copy Copies	the	selected	program. -

Paste

Pastes the copied program into a timetable.
If a program in the timetable is selected, the copied 
program	will	be	allocated	immediately	after	it	finishes.	If	
no programs are selected, it will be pasted at 00:00.

-

Option Set Timetable Span
Sets	the	timetable	to	a	target	time	span	(start	and	finish	
times). This is used for setting business hours as a time 
span, etc.

Fp.65

Help
About Panel Support Displays	“Table	of	supporting	panel	controls.” Fp.63
About	Timetable	Editor Displays	version	information	for	Timetable	Editor. -

3) Toolbar
The toolbar buttons (icons) perform the following actions:

Icon Menu option Description Relevant 
page

Open Timetable Loads	a	saved	timetable. Fp.66

Save Timetable Overwrites the currently edited timetable. Fp.65

4) Tabs
Clicking	a	tab	switches	to	the	settings	window	for	each	item.

5) Program/Panel Control list
When	the	[Program]	tab	is	selected,	the	program	folder,	program	thumbnails,	and	program	list	are	displayed.
For	more	details	about	the	program	folder	and	program	thumbnails,	refer	to	p.46.
When	the	[Panel	Control]	tab	is	selected,	the	list	of	panel	control	commands	is	displayed.

6) Timetable
Displays a timetable.

The main Timetable Editor window
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Creating a timetable

●Registering a program in the timetable
1. Check that the [Program] tab is selected.

If	it	is	not,	click	the	[Program]	tab	to	select	it.
The program list will be displayed here.
There	are	four	categories	in	the	list:	“Program	Name”,	
“Duration”,	“Screen	Size”,	and	“Screen	Position”.

	 The	color	of	the	icon	in	front	of	the	“Program	Name”	
represents	the	“Color	of	Program”.	Click	[Properties	
of	Program]	from	the	[File]	menu	in	“Program	
Editor”	to	change	it.	(Fp.48)

Program folder Program thumbnails2. Select the program folder containing the program.

3. From the “Program Name”, select a program, and click  , 
or alternatively, double-click the program.
The	[Add	Program	to	Timetable]	dialog	box	will	appear.

4. Set the “Play back time”.
This is the time of day when the program will be played.
Specify	times	between	00:00	and	24:00.

5. Click [OK].
The program will be registered to the timetable.

 Programs may also be registered by dragging 
them	from	the	“Program	Name”	to	the	“Timetable”.	
Registered programs can be changed in the 
Timetable. (Fp.64)

6. Repeat steps 2 to 4 as necessary and set all the 
programs that you want to display over the course of the 
day.

Creating a timetable
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●Registering panel control in a timetable
1. Click the [Panel Control] tab.

A list of panel control commands will be displayed.

There	are	two	categories:	“Command	Name”	and	“Input	Source”.	Commands	are	as	follows:

Command Description
Turn On Display *1 Turns the panel (monitor) power ON.
Turn Off Display Puts the panel (monitor) into standby mode.
Switch Input Source 
(Input	“No.”)	

Switches the panel (monitor) input source.

TV *2
Switch	the	input	source	of	the	panel	(monitor)	to	“TV	input”.	The	channel	at	the	
time	of	switching	to	the	TV	cannot	be	specified.	The	channel	that	was	selected	by	
the TV immediately before switching is displayed.

*1	 It	cannot	be	used	with	the	LB-46GX35	and	LB-52GX35.
*2	 It	cannot	be	used	with	the	SHARP	LCD	monitor	(PN	series)	and	the	LB-1085.

	 •	The	commands	supported	by	the	panel	(monitor)	
can	be	checked	with	“Table	of	supporting	panel	
controls.”

 •	To	display	“Table	of	supporting	panel	controls,”	
click the button ( )	“About	Panel	Support”	at	the	
lower left of the panel control command list. Or, click 
[About	Panel	Support]	from	[Help	Menu].

The	contents	of	“Table	of	supporting	panel	controls”	are	as	follows:

Menu option Description

RC-232C
Indicates the cable to be used for the connection (straight cable or cross cable).
Indicates transmission speeds supported.

LAN Indicates	whether	LAN	connection	is	supported.
Turn On Indicates	whether	the	“Turn	On	Display”	panel	control	command	is	supported.
Turn Off Indicates	whether	the	“Turn	Off	Display”	panel	control	command	is	supported.
Get	Status Indicates	whether	Get	Status	(Fp.101)	is	supported.
H/W	Error	Detection Indicates whether IDP hardware error detection is supported.
Time	Synchronization Indicates	whether	Time	Synchronization	(Fp.91,	92)	is	supported.
Input	“No.” Indicates which input of the panel (monitor) is supported.
TV Indicates whether TV input is supported.

Creating a timetable
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2. Select the panel control command you want to use from 
the “Command Name” and click .

The	[Add	Panel	Control	Command	to	Timetable]	dialog	box	
will appear.

3. Set the “Time”.
This	is	the	time	that	the	command	will	be	executed.
Specify	times	between	00:00	and	24:00.

4. Click [OK].
The panel control command will be registered in the timetable 
and the control command icons (Turn On Display: , Turn 
Off Display: , Switch Input Source: , TV: ) will be 
displayed to the right of the timetable.

	 Commands	may	also	be	registered	by	dragging	them	from	the	“Command	Name”	to	the	
“Timetable”.

5. Repeat steps 2 to 4 as necessary and set all the panel control commands that you want to execute 
over the course of the day.

Creating a timetable
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●Adjusting a timetable
Clicking	the	buttons	on	the	top	right	of	the	timetable	performs	the	following	actions:

Icon Menu option Description

Preview Program Displays	a	preview	of	the	selected	program	at	its	original	size.

Preview Program
(Fit	Screen)

Displays	a	preview	of	the	selected	program	fitted	to	the	size	of	the	
screen.

Properties for Program/
Command

Displays the properties of the selected program/panel control command.

Delete	Program/Command
Deletes the selected programs/panel control commands from the timetable. 
Programs/panel	control	command	may	also	be	deleted	by	pressing	[Delete].

Copy	Programs/
Panel	Control	Commands

Copies	the	selected	program/panel	control	command.

Paste Programs/
Panel	Control	Commands

Positions the copied program/panel control command into a timetable. If a 
program in the timetable is selected, the copied program will be allocated 
immediately	after	it	finishes.	If	no	programs	are	selected,	it	will	be	pasted	at	00:00.

Click	a	program	or	panel	control	command	positioned	on	the	
timetable to select it.
Drag	a	resize	handle	to	adjust	the	playback	time/time	for	the	
program	or	panel	control	command	and	confirm	the	changes	
visually.
The program and the panel control command can be moved by 
dragging	an	area	other	than	the	resize	handle	using	the	mouse.

Changing the timetable span

1. From the [Option] menu, click [Set Timetable Span].
The	[Timetable	Span]	dialog	box	will	appear.

2. Set the “Start” and “End” times.
Specify	times	between	00:00	and	24:00.

3. Click [OK].
The	new	times	will	be	reflected	in	the	timetable.

Creating a timetable
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Adjusting the scale
Select	intervals	of	5,	10,	15,	30	or	60	minutes	from	the	“Scale”	
list.

●Saving a timetable

Save timetable
Use	this	option	when	you	want	to	save	the	currently	edited	timetable	under	its	original	name.

1. From the [File] menu, click [Save Timetable]. 
You can also save a timetable by clicking .
The	timetable	file	will	be	overwritten	and	saved	with	the	same	name.

	 When	“Timetable	Editor”	is	started,	the	title	bar	will	read	“Untitled”.	If	you	attempt	to	save	at	this	
stage	the	[Save	Timetable]	dialog	box	will	be	displayed.	For	the	remaining	steps,	refer	to	step	2	of	
“Save	timetable	as”.

Save timetable as
Use	this	option	when	you	want	to	save	the	currently	edited	timetable	under	a	different	name.
1. From the [File] menu, click [Save Timetable As].

The	[Save	As]	dialog	box	will	appear.
2. Select the timetable folder in which the timetable is to be 

saved.
3. Enter a “Timetable Name” and click [Save].

The timetable will be saved with a different name.

●Opening a timetable
Load	a	timetable	that	you	have	already	saved,	and	use	it.
Editing	only	the	places	you	want	to	change	in	an	existing	file	and	saving	the	file	under	a	new	name	is	an	efficient	
way to create timetables.
1. From the [File] menu, click [Open Timetable]. 

You can also open a timetable by clicking .
The	[Open	Timetable]	dialog	box	will	appear.

2. Select the timetable folder containing the timetable.
3. From the “List of Timetable”, select a timetable, and 

click [Open].
The timetable you selected will be loaded into Timetable 
Editor	and	you	will	be	able	to	edit	it.

	 Take	care	when	saving	a	timetable	you	have	edited	using	the	[Save	Timetable]	option,	as	the	
changes	you	have	made	will	be	reflected	in	the	original	file.

Creating a timetable
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●Checking a timetable
Check	a	timetable	using	the	program	preview	function.

 All the registered schedule data and timetable data is erased in the SHARP Digital Signage Software 
standalone	version	(PN-SS01).

1. From the [File] menu, click [Preview Timetable].
A preview of the timetable will be displayed.

2. Check the preview.

	 •	To	close	the	preview,	click	the	preview	window	and	press	[Esc]	to	stop	the	display,	and	then	delete	
the	schedule	information	from	the	Client	Scheduler	of	the	task	tray.	(Fp.99)

 •	If	the	program	screen	size	is	larger	than	the	display	resolution	of	the	PC	monitor,	the	preview	will	
not be able to display the entire program screen.

●Deleting a timetable
Delete unnecessary timetables.
1. From the [File] menu, click [Delete Timetable].

The	[Delete	Timetable]	dialog	box	will	appear.

2. Select the timetable folder containing the timetable.

3. From the “List of Timetable”, select a timetable, and 
click [Delete].

4. Click [Yes].
The selected timetable is now deleted.

5. Click [Close].

●Changing timetable name and timetable color
1. From the [File] menu, click [Properties of Timetable].

The	[Properties	of	Timetable]	dialog	box	will	appear.

Check	the	“Name”	and	“Color”.
•	 The	“Name”	can	be	changed.
•	 Click	the	color	swatch	to	display	the	[Color]	dialog	box	

and change the timetable color.

	 The	“Color”	is	the	color	used	to	display	the	
timetable	in	Schedule	Editor.

2. Click [OK].

Creating a timetable
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●Importing/exporting a timetable

Exporting a timetable
The	export	function	is	used	to	write	out	a	timetable	so	that	it	can	be	used	with	this	product	on	another	PC.	
Exported	timetable	data	includes	programs	registered	in	timetables.

1. From the [File] menu, click [Export Timetable].
The	[Export	Timetable]	dialog	box	will	appear.

2. Select the timetable folder containing the timetable.

3. From the “List of Timetable”, select a timetable, and 
click [Export].
The	[Select	the	folder	to	export]	dialog	box	will	appear.

4. Specify the directory where you want to save the file, 
enter a “File name”, and click [Save].
The	[Export	Timetable]	dialog	box	will	appear.

 A screen like the one on the right will appear during 
the	export.	Click	[Cancel]	to	cancel	the	export.

5. Click [OK].
The	timetable	export	is	now	complete.

Creating a timetable
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Importing a timetable
The	import	function	is	used	to	load	an	exported	timetable	that	has	been	created	with	this	product	on	another	PC.	
1. From the [File] menu, click [Import Timetable].

The	[Select	the	timetable	to	import]	dialog	box	will	appear.

2. Select a (.tbl) file to import, and click [Open].
The	[Import	Timetable]	dialog	box	will	appear.

 A screen like the one on the right will appear while 
the	import	is	being	prepared.	Click	[Cancel]	to	
cancel the import.

3. Select the timetable folder in which the timetable is to be 
saved.

4. Enter a “Timetable Name” and click [Import].

	 If	the	same	program	already	exists	on	the	PC	
where	the	import	is	to	be	used,	a	confirmation	
dialog	box	will	appear.	Choose	whether	to	overwrite	
the	existing	file	or	import	the	file	under	a	new	name.

5. Click [Yes].
The timetable will be saved with the name you entered.
The timetable import is now complete.

Creating a timetable
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Creating/Editing Schedules
Set	timetables	created	with	Timetable	Editor	to	display	on	a	set	day.

The main Schedule Editor window

●Launching Schedule Editor
1. Click  on the Launcher window.

“Schedule	Editor”	will	launch.

When	Schedule	Editor	launches,	a	new	blank	schedule	with	no	timetables	assigned	will	be	displayed.	
Schedules are completed after timetable is set on this screen.

	 Schedule	Editor	can	also	be	started	by	going	to	the	Windows	Taskbar,	and	clicking	[Start],	[All	
Programs],	[SHARP	Digital	Signage	Software],	[Tools],	and	then	[Schedule	Editor].

●The main Schedule Editor window

1)	Title	bar

2)	Menus

3) Toolbar

4)	“Timetable”	list

5)	Calendar1) Title bar
The name of the schedule will be displayed here.
When	Schedule	Editor	launches,	the	title	bar	will	read	“Untitled”.	When	a	schedule	is	saved,	it	will	change	to	the	
name of the schedule. When content of an opened schedule is changed, the title bar will display an asterisk (*) 
after the schedule name.

2) Menus
Menu options are as follows:

Menu option Description Relevant 
page

File
Create	New	Schedule Opens a new schedule. -
Open Schedule Loads	a	saved	schedule. Fp.74
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The main Schedule Editor window

Menu option Description Relevant 
page

File

Save Schedule Overwrites the currently edited schedule Fp.74
Save Schedule As Saves the currently edited schedule under a different name. Fp.74
Delete Schedule Allows the user to specify and delete saved schedules. Fp.75

Properties of Schedule
Allows the user to display and change the schedule 
name. Fp.75

Import Schedule
Reads	a	schedule	that	has	been	exported	from	another	
PC	so	that	it	can	be	used. Fp.77

Export	Schedule
Writes out a schedule so that it can be used on another 
PC. Fp.76

Exit Exits	Schedule	Editor. -

Edit

Add Timetable to Schedule
Adds	the	timetable	that	is	selected	in	the	“Timetable”	
list to the schedule. Fp.72

Delete Timetable from 
Schedule

Deletes	the	timetable	that	is	selected	in	the	“Calendar”.	
Timetable	may	also	be	deleted	by	pressing	[Delete]. Fp.73

Copy	Timetable Copies	the	selected	timetable. -
Paste Timetable Pastes the copied timetable into a schedule. -
Select All Selects all timetables in the schedule. -

View

Show Previous Month
Displays the month before the month that is currently 
displayed in the calendar. Fp.73

Show	Next	Month
Displays the month after the month that is currently 
displayed in the calendar. Fp.73

Show This Month Displays the current month in the calendar. Fp.73
Refresh Updates	the	“Timetable”	list. -

Help About	Schedule	Editor Displays	version	information	for	Schedule	Editor. -

3) Toolbar
The toolbar buttons (icons) perform the following actions:

Icon Menu option Description Relevant 
page

Open Schedule Loads	a	saved	schedule. Fp.74

Save Schedule Overwrites the currently edited schedule. Fp.74

Delete Timetable
Deletes	the	timetable	that	is	selected	in	the	“Calendar”.	
Timetable	may	also	be	deleted	by	pressing	[Delete]. Fp.73

Copy	Timetable Copies	the	selected	timetable. -

Paste Timetable Pastes the copied timetable into a schedule. -

4) “Timetable” list
The	timetable	folder	and	the	list	of	timetables	created	with	Timetable	Editor	are	displayed.
In	the	list	of	timetable,	there	are	two	categories:	“Name”	and	“Last	Modified	Time”.

	 The	color	of	the	icon	in	front	of	the	name	of	each	timetable	represents	the	“timetable	color”.	Click	
[Properties	of	Timetable]	from	the	[File]	menu	in	“Timetable	Editor”	to	change	it.	(Fp.73)

5) Calendar
Timetables are positioned on the calendar to create schedules.
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Creating a schedule

●Registering a timetable in the schedule
Timetable folder1. Select the timetable folder containing the timetable.

2. Select a timetable from the “Timetable” list and click 
 
,

 or alternatively, double-click the timetable, or from the 
[Edit] menu, click [Add Timetable to Schedule].
The	[Add	Timetable	to	Schedule]	dialog	box	will	appear.

3. Set a “Span”.
This is the length of time that the program will be played for.
Specify	dates	between	1/1/2005	and	12/31/2020.
If	you	do	not	set	the	“Option”	area,	the	time	schedule	will	be	
added	to	the	entire	span	from	“Start”	to	“End”.

Use	the	“Option”	settings	to	add	timetables	to	specified	days	
or weeks.

•	 If	you	check	the	“Select	the	day(s)	of	the	week	below:”	
check	box	and	the	“Sunday”	to	“Saturday”	check	boxes,	
the	timetable	will	only	be	added	to	the	specified	days	of	
the week during the span.

•	 If	you	check	the	“Select	the	week(s)	of	the	month	
below:”	check	box	and	the	“1st	week”	to	“6th	week”	
check	boxes,	the	timetable	will	only	be	added	to	the	
specified	weeks	during	the	span.

•	 If	you	specify	both	“Select	the	day(s)	of	the	week	below:”	
and	“Select	the	week(s)	of	the	month	below:”,	the	timetable	
will only be added to days that meet both sets of conditions.

	 For	example,	setting	“Select	the	day(s)	of	the	week	below:”	to	“Wednesday”,	and	“Select	the	week(s)	of	
the	month	below:”	to	“2nd	week”,	would	add	the	timetable	to	the	second	Wednesday	of	every	month.

4. Click [OK].
The timetable will be registered in the schedule.

 Timetables may also be registered by dragging 
them	from	the	“Timetable”	list	to	the	“Calendar”.		 
Registered timetables can be changed in the 
calendar. (Fp.64)

5. Repeat steps 2 to 3 as necessary and add all the 
timetables that you want to display to the schedule.
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The calendar
The	calendar	can	display	dates	between	January	2005	and	December	2020.
Days	on	which	a	timetable	is	registered	show	the	“timetable	color”	and	the	“timetable	name”.

The buttons and lists at the top of the calendar perform the following actions:

Icon Menu option Description

Show Previous Month Displays the month before the month that is currently displayed.

Select	Year Displays the year selected for the month that is currently displayed.

Select Month Displays the month selected for the year that is currently displayed.

Show	Next	Month Displays the month after the month that is currently displayed.

Show This Month Displays the current month.

	 •	Click	while	holding	down	[Ctrl]	or	[Shift]	to	select	multiple	days	at	the	same	time.
 •	Select	a	timetable	and	press	[Delete]	to	delete	it	from	the	calendar.

Timetables are registered to different days depending on where they are dragged on the calendar.
Days that already have timetables registered to them will not be overwritten.

1)	Dates

2)	Weekday	titles

3) Week titles

4)	All

1)	Dates	:	 Timetables	will	be	added	to	the	day	to	which	they	are	dragged.
2)	Weekday	titles:		Timetables	will	be	added	to	the	day	of	the	week	to	which	they	are	dragged	for	the	currently	

displayed month.
3) Week titles:  Timetables will be added to the week to which they are dragged for the currently displayed 

month.
4)	All	:	 Timetables	will	be	added	to	every	day	of	the	currently	displayed	month.

Creating a schedule
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●Saving a schedule

Save schedule
Use	this	option	when	you	want	to	save	the	currently	edited	schedule	under	its	original	name.
1. From the [File] menu, click [Save Schedule]. 

You can also save a schedule by clicking .
The	schedule	file	will	be	overwritten	and	saved	with	the	same	name.

	 When	“Schedule	Editor”	is	started,	the	title	bar	will	read	“Untitled”.	If	you	attempt	to	save	at	this	
stage	the	[Save	Schedule]	dialog	box	will	be	displayed.	For	the	remaining	steps,	refer	to	step	2	of	
“Save	schedule	as”.

Save schedule as
Use	this	option	when	you	want	to	save	the	currently	edited	schedule	under	a	different	name.
1. From the [File] menu, click [Save Schedule As].

The	[Save	Schedule	As]	dialog	box	will	appear.
2. Select the schedule folder in which the schedule is to be 

saved.
3. Enter a “Schedule Name”, and click [Save].

The schedule will be saved with a different name.

●Opening a schedule
Load	a	schedule	that	you	have	already	saved,	and	use	it.
Editing	only	the	places	you	want	to	change	in	an	existing	file	and	saving	the	file	under	a	new	name	is	an	efficient	
way to create schedules.
1. From the [File] menu, click [Open Schedule]. 

You can also open a schedule by clicking .
The	[Open	Schedule]	dialog	box	will	appear.

2. Select the schedule folder containing the schedule.
3. From the “List of Schedule”, select a schedule, and click 

[Open].
The schedule you selected will be loaded into Schedule 
Editor	and	you	will	be	able	to	edit	it.

	 Take	care	when	saving	a	schedule	you	have	edited	using	the	[Save	Schedule]	option,	as	the	
changes	you	have	made	will	be	reflected	in	the	original	file.
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●Deleting a schedule
Delete unnecessary schedules.
1. From the [File] menu, click [Delete Schedule].

The	[Delete	Schedule]	dialog	box	will	appear.

2. Select the schedule folder containing the schedule.

3. From the “List of Schedule”, select a schedule, and click 
[Delete].

4. Click [Yes].
The selected schedule will be deleted.

5. Click [Close].

●Changing schedule name
1. From the [File] menu, click [Properties of Schedule].

The	[Properties	of	Schedule]	dialog	box	will	appear.

Check	the	schedule	name	and	change	it	if	you	wish.

2. Click [OK].

Creating a schedule
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●Importing/exporting a schedule

Exporting a schedule
The	export	function	is	used	to	write	out	a	schedule	so	that	it	can	be	used	with	this	product	on	another	PC.	
Exported	schedule	data	includes	programs	and	timetables	that	are	registered	to	the	schedule.

1. From the [File] menu, click [Export Schedule].
The	[Export	Schedule]	dialog	box	will	appear.

2. Select the schedule folder containing the schedule.

3. From the “List of Schedule”, select a schedule, and click 
[Export].
The	[Select	the	folder	to	export]	dialog	box	will	appear.

4. Specify the directory where you want to save the file, 
enter a “File name” and click [Save].
The	[Export	Schedule]	dialog	box	will	appear.

 A screen like the one on the right will appear during 
the	export.	Click	[Cancel]	to	cancel	the	export.

5. Click [OK].
The	schedule	export	is	now	complete.
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Importing a schedule
The	import	function	is	used	to	load	an	exported	schedule	that	has	been	created	with	this	product	on	another	PC.	
1. From the [File] menu, click [Import Schedule].

The	[Select	the	schedule	to	import]	dialog	box	will	appear.

2. Select a (.sch) file to import, and click [Open].
The	[Import	Schedule]	dialog	box	will	appear.

 A screen like the one on the right will appear while 
the	import	is	being	prepared.	Click	[Cancel]	to	
cancel the import.

3. Select the schedule folder in which the schedule is to be 
saved.

4. Enter a “Schedule Name”, and click [Import].

 If the same program name or timetable name 
already	exists	on	the	PC	where	the	import	is	to	be	
used,	a	confirmation	dialog	box	will	appear.	Choose	
whether	to	overwrite	the	existing	files	or	import	
them under a new name.

5. Click [Yes].
The schedule will be saved with the name you entered.
The schedule import is now complete.

Creating a schedule
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Panel Management and Option
When	distributing	programs	to	multiple	panels	with	the	Network	Version,	you	must	first	set	the	panels.

Managing panels

 This function is only available with the Network Version.

●Launching Panel Control Management
1. Click  on the Launcher window. 

The	[Panel	Management]	dialog	box	will	appear.

●The main Panel Management window

1) The “List of registered panel” tree
Displays a list of all registered panels.
Panel icons ( )	can	be	dragged	and	dropped	inside	this	list	to	change	their	attribution	(“(All	Panels)”	or	an	
“arbitrary	group”).

	 The	number	of	panels	that	can	be	managed	depends	on	the	license.	(Maximum	limit	is	100	panels)

1)		The	“List	of	registered	
panel”	tree

2)	Buttons
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2) Buttons
The buttons perform the following actions:

Name Description Relevant page
Add Panel Adds a new panel to be managed. FBelow
Add	Group Adds a new group. Fp.80
Edit Changes	the	content	of	the	selected	panel	or	group. FBelow,	p.80
Delete Deletes the selected panel or group. Fp.81
Manual	Control Sets panels and control commands to be controlled manually. Fp.81
Exit Closes	the	[Panel	Management]	window. -

●Adding/editing a panel
1. Click [Add Panel] to add a new panel to manage.

The	[Add	Panel	(Panel	PC)]	dialog	box	will	appear.

 Click [Edit] to edit an existing panel. 
The	[Edit	Panel	(Panel	PC)]	dialog	box	will	appear.

	 The	settings	for	the	[Add	Panel	(Panel	PC)]	and	[Edit	Panel	(Panel	PC)]	dialog	boxes	are	the	
same. Panels can also be edited after they have been added.

2. Set the options.
1)	Panel	name	(Compulsory)
	 Choose	a	name	that	will	make	it	easy	to	identify	the	

panel.	(Names	must	be	within	50	characters)

2)	Group
	 In	the	Group	box,	select	a	group	to	add	the	panel	to.
 If you do not want to assign the panel to any particular 

group,	select	“(none)”.	Panels	that	are	not	assigned	to	
any	particular	group	will	be	added	under	“All	Panels”.

	 Clicking	[Add	Panel]	while	the	“List	of	registered	
panel”	tree	group	or	a	panel	assigned	to	a	group	is	
selected will add the panel to the respective group.

3)	Host	name	or	IP	address	(Compulsory)
	 Sets	the	host	name	or	IP	address	of	target	PC	which	can	be	accessed	from	the	server.

 It is not possible to create two or more panels with the same host name or IP address.

Managing panels
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4)	MAC	address
	 Set	the	MAC	address	for	the	target	PC	if	you	want	to	turn	it	on	from	the	controller	PC.

5)	FTP	Setting
	 Enter	the	“User	name”	(within	30	alphanumeric	characters),	“Password”	(within	30	alphanumeric	

characters),	and	“Port	number”	(1-32000)	that	you	set	for	the	target	PC	FTP	settings.

	 •	FTP	settings	for	adding	a	panel	can	be	set	in	advance.	(Fp.83)
 •	If	you	have	installed	the	Viewer	Version,	a	unique	FTP	Server	will	be	installed,	and	started	as	a	

service.	The	default	TCP/IP	port	numbers	are	20	and	21.	If	this	port	number	is	already	used	by	
another	service,	change	the	port	number.		The	FTP	settings	of	the	target	PC	Client	Scheduler	
must use the same port number. (Fp.101)

6)	Power	Control
	 If	you	want	to	turn	the	power	of	the	target	PC	on	or	off	at	a	specified	time,	select	the	“Specify	to	power	

on/off	the	panel	through	the	server	at	the	designated	time”,	and	set	the	“Time	to	start”	and	“Time	to	
end”.	(Times	can	be	specified	in	increments	of	5	minutes)

3. Click [Add] or [Cancel].

●Adding/editing a group
1. To add a group, click [Add Group].

The	[Add	Group]	dialog	box	will	appear.

 To edit a group, select the group you want to edit and click [Edit]. 
The	[Edit	Group]	dialog	box	will	appear.

	 •	A	group	can	be	created	within	a	group
 •	It	is	not	possible	to	create	two	or	more	groups	with	the	same	name.

2. Select the parent group.

3. Enter a “Group name”.
(Names	must	be	within	50	characters)

4. Click [Add] or [Cancel].
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●Controlling a panel manually
Set	this	option	when	you	want	to	control	the	target	PC	manually.

	 When	controlling	the	target	PC	manually,	(when	turning	on	the	panel	PC),	the	Wake	On	LAN	function	
that	operates	by	Magic	Packets	sent	from	the	target	PC	must	be	enabled.

 If	the	target	PC	is	outside	the	same	LAN	segment,	Magic	Packets	may	not	get	through	depending	on	
router	specs	and	settings.	Contact	your	network	administrator	for	more	details.

1. Click [Manual Control].
The	[Manual	Control	for	the	Panel	(Panel	PC)]	dialog	box	will	appear.

2. Check the check boxes next to the panels or groups that 
you want to control.
Select	a	“Control	Command”.
The following three control commands can be sent:
•	PC	Power	ON
•	PC	Reboot
•	PC	Power	OFF

3. Click [Execute].
The control command will be sent.

●Deleting a panel or group
1. Select the panel or group that you want to delete.

 If you select a group, all the panels assigned to that 
group will be deleted.

2. Click [Delete].
A	confirmation	dialog	box	will	appear.

3. Click [OK].

Managing panels
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Option
Option allows you to check product version information and to set values for adding panels in advance.

●Launching Option
1. Click  on the Launcher window. 

The	[Option]	dialog	box	will	appear.

●Checking version information
The	[Version]	tab	displays	version	information.	

Registering a license code
If you input a temporary license code when installing, you will only be able to use the software for a two-month 
trial period. Register your license code before the end of the trial period.

1. Click [Register].
The	[Register	License	Code]	dialog	box	will	appear.

2. Enter your “license code” and click [Register].

	 If	using	Windows	Vista/7,	click	[Allow]	(for	Windows	
Vista)	or	[Yes]	(for	Windows	7)	if	a	User	Account	
Control	window	appears.
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●Adding default panel settings for panels
Set	default	values	for	FTP	settings	that	are	applied	to	all	newly-added	panels.
1. Click the [FTP Setting] tab.
2. Set the [Default to Add the Panel].

•	User	name	(within	30	alphanumeric	characters)	
•	Password	(within	30	alphanumeric	characters)	
•	Port	number	(1-32000)

The initial default values are:
•	User	name:	ftp
•	Password:	ftp
•	Port	number:	21

	 •	If	you	have	installed	the	Viewer	Version,	a	unique	FTP	Server	will	be	installed,	and	started	as	a	service.	
The	default	TCP/IP	port	numbers	are	20	and	21.	If	this	port	number	is	already	used	by	another	service,	
change	the	port	number.	The	FTP	settings	of	the	target	PC	Client	Scheduler	must	use	the	same	port	
number. (Fp.101)

 •	The	port	number	should	also	be	changed	if	there	are	security	issues.

Option
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Distribute	schedules	created	with	Schedule	Editor	to	the	target	PC.

The main Schedule Distribution Tool window

●Launching Schedule Distribution Tool
1. Click  on the Launcher window.

“Schedule	Distribution	Tool”	will	launch.

	 Schedule	Distribution	Tool	can	also	be	started	by	going	to	the	Windows	Taskbar	and	clicking	[Start],	[All	
Programs],	[SHARP	Digital	Signage	Software],	[Tools],	and	then	[Schedule	Distribution	Tool].

●The main Schedule Distribution Tool window

1)		Distribution	settings	button

2)	Tabs

3)  Distribution Reservation/
Log	window

1) Distribution settings button
Launches	a	wizard	for	system	and	distribution	method	settings.

2) Tabs
Clicking	a	tab	switches	to	the	list	window	for	each	item.

3) Distribution Reservation/Log window
Displays details for the selected tab.

Distributing schedules
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Distributing schedules
Schedules can be distributed in the following ways: 
•	Distributed	to	a	target	PC	via	a	network	(Network	Version	only)	
•	Distributed	to	your	own	PC	
•	Distributed	via	USB	memory	or	other	external	device

	 The	maximum	total	size	of	schedules	(including	programs	and	content)	that	can	be	distributed	with	
Schedule	Distribution	Tool	is	2	GB.	Data	greater	than	this	size	cannot	be	distributed.

●Distributing via a network
Distribute	schedules	to	the	target	PC	via	a	network.

 These instructions only apply to the Network Version.

1. Click [Distribute schedule or program to the panel].
The	[Selection	of	Distribution	Methods]	dialog	box	will	appear.

2. Select the “Distribute the schedule through the network” 
option button, and click [Next]. 
The	[Selection	the	Schedule	to	Distribute]	dialog	box	will	
appear.

3. Select a schedule.
If you would like to add the selected schedule to the current 
schedule	on	the	target	PC,	check	the	“Add	this	schedule	on	
the	running	schedule	in	the	target	panel”	check	box.	If	the	box	
is	not	checked,	the	current	schedule	on	the	target	PC	will	be	
replaced with the currently selected schedule.

 Schedule replacement is performed in units of 
days. It cannot be changed to units of hours.

4. Click [Next].
The	[Selection	of	the	Distribution	Target]	dialog	box	will	appear.

Distributing schedules
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5. Check the check boxes for all the panels and/or groups 
that the schedule is to be sent to. 
Clicking	the	buttons	in	the	top	right	of	the	window	will	allow	
you to add or edit panels and groups in the same way as the 
[Panel	Management]	window	(Fp.78).

The buttons perform the following actions:

Button Name Description Relevant page

Add	Panel	(Panel	PC) Adds a new panel to be managed. Fp.79

Add	Group Adds a new group. Fp.80

Edit	Panel/Group
Changes	the	content	of	the	selected	panel	or	
group. Fp.79-80

Delete	Panel/Group Deletes the selected panel or group. Fp.81

6. Click [Next].
The	[Selection	of	the	Distribution	Date	Time	and	Option]	dialog	box	will	appear.

7. Select a “Distribution Date Time”.
•	 “Distribute	now”	option	button
	 Distributes	schedule	as	soon	as	the	distribution	wizard	
exits.

•	 “Distribute	at	specified	date	time”	option	button
 Distributes schedule at the set date and time.

8. Set “Distribution Options”.
•	 “Power	ON	the	panel	PC	before	the	distribution”	check	box
	 Distributes	the	schedule	after	turning	the	target	PC	on	if	it	is	not	

already turned on at the time of distribution.
•	 “Power	OFF	the	panel	PC	after	the	distribution”	check	box
	 Turns	the	target	PC	power	off	after	the	schedule	has	been	distributed.

9. Click [Next].
A	[Confirmation]	dialog	box	will	appear.

10. Check the distribution settings, and click [Finish].
The	distribution	or	distribution	reservation	will	be	executed.

 Distribution data can be packaged and saved as 
a	single	file	that	includes	schedule	information	
including programs, timetables, and content.

 Click	[Save	the	Package],	and	in	the	[Save	the	
Package]	dialog	box	that	appears,	specify	a	
directory	to	save	the	file	to.	Then	enter	a	“File	
name”,	and	click	[Save].	There	is	usually	no	need	to	
use this function.
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11. If you selected the “Distribute now” option button in step 
7, a screen like the one on the right will appear. Check 
that the distribution was successful and click [Close].

 If you selected the “Distribute at specified date time” 
option button in step 7, a screen like the one on the right 
will appear. Click [OK].

	 •	Schedule	and	program	distribution	may	take	some	time.	If	you	perform	simultaneous	distribution	to	
multiple	panels,	data	is	actually	sent	sequentially.	For	this	reason,	there	may	be	some	time	difference	in	
schedule and program distribution.

 •	Old	schedules	are	no	longer	required	after	new	schedules	have	been	sent.	Unnecessary	schedules	and	
their	associated	content	will	be	automatically	deleted	the	next	time	Client	Scheduler	starts.

●Distributing to your own PC

 These instructions only apply to the Standalone Version.

1. Click [Distribute schedule or program to the panel].
The	[Selection	of	Distribution	Methods]	dialog	box	will	appear.

2. Select the “Distribute the schedule to your PC (My 
computer)” option button, and click [Next]. 
The	[Selection	the	Schedule	to	Distribute]	dialog	box	will	
appear.

3. Select a schedule.
If you want to add the selected schedule to the current open 
schedule	on	your	PC,	check	the	“Add	this	schedule	on	the	
running	schedule	in	the	target	panel”	check	box.	If	the	box	is	
not	checked,	the	currently	open	schedule	on	your	PC	will	be	
replaced with the currently selected schedule.

4. Click [Next].
A	[Confirmation]	dialog	box	will	appear.

Distributing schedules
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5. Check the distribution settings, and click [Finish].
The	distribution	will	be	executed.

 Distribution data can be packaged and saved as 
a	single	file	that	includes	schedule	information	
including programs, timetables, and content.

 Click	[Save	the	Package],	and	in	the	[Save	the	
Package]	dialog	box	that	appears,	specify	a	
directory	to	save	the	file	to.	Then	enter	a	“File	
name”,	and	click	[Save].	There	is	usually	no	need	to	
use this function.

6. A screen like the one on the right will appear. Check that 
the distribution was successful and click [Close].

●Distributing with USB memory or other external storage device

	 •	Do	not	remove	the	USB	memory	or	other	external	storage	device	from	your	PC	until	the	transfer	is	
complete.

 •	Certain	USB	devices	and	other	external	storage	devices	may	not	be	able	to	distribute	correctly.
 •	Set	the	target	PC	to	“Normal	mode.”	If	it	is	set	to	“Contents	direct	distribute	mode,”	schedules	cannot	be	

distributed (Fp.103).

1. Click [Distribute schedule or program to the panel].
The	[Selection	of	Distribution	Methods]	dialog	box	will	appear.

2. Select the “Distribute the schedule using external 
storage such as USB memory” option button, and click 
[Next].
The	[Selection	the	Schedule	to	Distribute]	dialog	box	will	
appear.
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3. Select a schedule.
If you would like to add the selected schedule to the currently 
open	schedule	on	the	target	PC,	check	the	“Add	this	
schedule	on	the	running	schedule	in	the	target	panel.”	check	
box.	If	the	box	is	not	checked,	the	currently	open	schedule	
on	the	target	PC	will	be	replaced	with	the	currently	selected	
schedule.

4. Click [Next].
The	[Selection	of	the	Drive	to	Transfer]	dialog	box	will	appear.

5. Select the drive to which you want to transfer the schedule to.

6. Click [Next].
A	[Confirmation]	dialog	box	will	appear.

7. Check the distribution settings, and click [Finish].
The	distribution	will	be	executed.

 Distribution data can be packaged and saved as a single 
file	that	includes	schedule	information	including	programs,	
timetables, and content.

 Click	[Save	the	Package],	and	in	the	[Save	the	Package]	
dialog	box	that	appears,	specify	a	directory	to	save	the	
file	to.	Then	enter	a	“File	name”,	and	click	[Save].	There	is	
usually no need to use this function.

8. Click [Yes].
A	confirmation	dialog	box	will	appear	again.

9. Click [OK].

10. Remove the USB memory or other storage device from 
the PC.

	 If	you	clicked	[No]	in	step	8,	remove	the	device	via	the	Safely	Remove	Hardware	icon	( ) in the 
Task Tray.

11. Connect the USB memory or other external storage device to the target PC.
The	schedule	will	be	automatically	distributed.	The	USB	memory	or	other	external	storage	device	will	
automatically	stop	when	the	distribution	is	complete.	Check	the	message,	and	remove	the	device.

Distributing schedules
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Displaying break-in programs

●Distributing via a network and making a break-in display

	 •	This	function	is	only	available	with	the	Network	Version.
 •	If	ordinary	schedule	distribution	and	break-in	distribution	overlap,	the	break-in	distribution	has	the	higher	

priority in processing.

1. Click [Distribute schedule or program to the panel].
The	[Selection	of	Distribution	Methods]	dialog	box	will	appear.

2. Select the “Distribute the program through network and make a 
break-in display” radio button, and click [Next].
The	[Selection	of	the	Break-in	Program]	dialog	box	will	appear.

3. Select a program, and click [Next].
The	[Selection	of	the	Distribution	Target]	dialog	box	will	appear.

4. Check the check boxes for all the panels and/or groups that the 
schedule is to be sent to. 
Clicking	the	buttons	in	the	top	right	of	the	window	will	allow	you	
to	add	or	edit	panels	and	groups	in	the	same	way	as	the	[Panel	
Management]	window	(Fp.78).	For	a	description	of	button	actions,	
refer	to	p.86.

5. Click [Next].
The	[Display	Time	and	Periods	of	Break-in	Program]	will	appear.
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6. Set the “Display Time of Break-in Program” area.
•	 “Display	the	break-in	program	as	soon	as	distribution	has	been	
completed”	option	button

	 Displays	the	program	as	soon	as	the	distribution	wizard	exits.
•	 “Start	the	break-in	program	at	the	time	specified”	option	button
 Starts program display at the set time.

7. Set a “Display Time”

8. If you want to perform panel control operations before 
and after a break-in program, check the “Conduct panel 
control before and after the program display” check box, 
and click [Next]. 
The	[Specification	of	Panel	Control	Command]	dialog	box	will	
appear.

 If you do not want to perform panel control operations before and after a break-in program, clear the 
“Conduct panel control before and after the program display” check box, and click [Next].
A	[Confirmation]	dialog	box	will	appear.	Proceed	to	step	11.

9. Set the [Panel Control Command].
“Before	Display	the	Break-in	Program”
•	 “Power	ON	the	panel	before	display	the	program”	check	
box	

 Turns the panel on before displaying the break-in 
program.

	 *	It	cannot	be	used	with	the	LB-46GX35	and	LB-52GX35.
•	 “Switch	the	panel	input	before	display	the	program	as	
below”	check	box

	 Switches	to	the	specified	input	before	displaying	the	
break-in program.

“After	Display	the	Break-in	Program”
•	 “Power	OFF	the	panel	after	display	the	program”	check	box
	 Turns	the	panel	off	after	the	break-in	program	has	finished.
•	 “Switch	the	panel	input	after	display	the	program	as	below”	check	box
	 Switches	to	the	specified	input	after	displaying	the	break-in	program.

10. Click [Next].
A	[Confirmation]	dialog	box	will	appear.

11. Check the distribution settings, and click [Finish].
The break-in program display or display reservation will be 
executed.

 By packaging distribution data, program information 
containing break-in programs and other contents 
can	be	saved	as	a	single	file.

 Click	[Save	the	Package],	and	in	the	[Save	the	
Package]	dialog	box	that	appears,	specify	a	
directory	to	save	the	file	to.	Then	enter	a	“File	
name”,	and	click	[Save].	There	is	usually	no	need	to	
use this function.

Displaying break-in programs
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12. A screen like the one on the right will appear. Check that 
the distribution was successful and click [Close].

	 •	If	the	set	time	has	already	passed	the	break-in	program	
will not be displayed.

 •	Once	the	break-in	program	has	been	displayed	in	the	
target	panel	for	the	amount	of	time	specified	in	“Display	
Time”,	the	panel	will	return	to	the	original	program.	
Display will resume from the start of the program that 
would otherwise have been playing when the break-in 
program ends.

 •	Whether	a	break-in	program	has	ended	is	checked	every	minute	(at	second	00).	The	point	at	which	the	
display	of	the	break-in	program	ends	and	the	original	program	starts	is	the	first	second	00	after	the	end	
of the break-in program.

 •	Only	one	break-in	program	can	be	registered.	Programs	distributed	later	will	be	given	priority.

●Distributing to your own PC and making a break-in display

 This function is only available with the Standalone Version.

1. Click [Distribute schedule or program to the panel].
The	[Selection	of	Distribution	Methods]	dialog	box	will	appear.

2. Select the “Distribute the break-in program to your PC 
(My computer)” option button, and click [Next].
The	[Selection	of	the	Break-in	Program]	dialog	box	will	
appear.

3. Select a program, and click [Next].
The	[Display	Time	and	Periods	of	Break-in	Program]	will	
appear.
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4. Set the “Display Time of Break-in Program” area.
•	 “Display	the	break-in	program	as	soon	as	distribution	has	
been	completed”	option	button

	 Displays	the	program	as	soon	as	the	distribution	wizard	
exits.

•	 “Start	the	break-in	program	at	the	time	specified”	option	
button

 Starts program display at the set time.

5. Set a “Display Time”

6. If you want to perform panel control operations before and after a break-in program, check the 
“Conduct panel control before and after the program display” check box, and click [Next].
The	[Specification	of	Panel	Control	Command]	dialog	box	will	appear.

 If you do not want to perform panel control operations before and after a break-in program, clear the 
“Conduct panel control before and after the program display” check box, and click [Next].
A	[Confirmation]	dialog	box	will	appear.	Proceed	to	step	9.

7. Set the [Panel Control Command].
“Before	Display	the	Break-in	Program”
•	 “Power	ON	the	panel	before	display	the	program”	check	box	
 Turns the panel on before displaying the break-in program. 
	 *	It	cannot	be	used	with	the	LB-46GX35	and	LB-52GX35.
•	 “Switch	the	panel	input	before	display	the	program	as	
below”	check	box

	 Switches	to	the	specified	input	before	displaying	the	
break-in program.

“After	Display	the	Break-in	Program”
•	 “Power	OFF	the	panel	after	display	the	program”	check	box
	 Turns	the	panel	off	after	the	break-in	program	has	finished.	
•	 “Switch	the	panel	input	after	display	the	program	as	below”	check	box
	 Switches	to	the	specified	input	after	displaying	the	break-in	program.

8. Click [Next].
A	[Confirmation]	dialog	box	will	appear.

9. Check the distribution settings, and click [Finish].
The break-in program display or display reservation will be 
executed.

 By packaging distribution data, program information 
containing break-in programs and other contents 
can	be	saved	as	a	single	file.

 Click	[Save	the	Package],	and	in	the	[Save	the	
Package]	dialog	box	that	appears,	specify	a	
directory	to	save	the	file	to.	Then	enter	a	“File	
name”,	and	click	[Save].	There	is	usually	no	need	to	
use this function.

Displaying break-in programs
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10. A screen like the one on the right will appear. Check that 
the distribution was successful and click [Close].

	 •	If	the	set	time	has	already	passed	the	break-in	program	will	not	be	displayed.
 •	Once	the	break-in	program	has	been	displayed	in	the	target	panel	for	the	amount	of	time	specified	in	

“Display	Time”,	the	panel	will	return	to	the	original	program.	Display	will	resume	from	the	start	of	the	
program that would otherwise have been playing when the break-in program ends.

 •	Whether a break-in program has ended is checked every minute (at second 00). The point at which the display of the 
break-in	program	ends	and	the	original	program	starts	is	the	first	second	00	after	the	end	of	the	break-in	program.
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List of Reserved Distribution/List of Distribution Log

●List of Reserved Distribution
Click	the	[Reserved	Distribution]	tab	to	display	the	list	of	currently	reserved	distributions.	There	are	five	
categories:	Schedule	Name,	Distribution	Target,	Reserved	Date	Time,	Power	ON,	and	Power	OFF.	Clicking	on	a	
category	will	organize	the	reservations	in	ascending	or	descending	order.

Deleting reserved distributions
Reserved distributions can be deleted by any of the following three methods:
•	Select	a	reservation	and	click	the	button	at	the	top	right	of	the	list	( ).
•	Right-click	on	a	reservation,	and	from	the	menu	that	appears,	click	[Delete	the	Reserved	Distribution].
•	Select	a	reservation	and	press	[Delete].

Updating
Reserved distributions can be updated by either of the two following methods:
•	Right-click	in	the	Reserved	Distribution	List,	and	from	the	menu	that	appears,	click	[Refresh	the	Information].
•	Press	[F5].

●List of Distribution Log
Click	the	[Distribution	Log]	tab	to	display	a	distribution	log	of	schedules	and	break-in	programs.
There	are	eight	categories:	Schedule	Name,	Distribution	Target,	Complete	Date	Time,	Type,	Result,	Start	Date	
Time,	Data	Size,	and	Detail	Information.	Clicking	on	a	category	will	organize	the	reservations	in	ascending	or	
descending order.

List of Reserved Distribution/List of Distribution Log
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Deleting the entire distribution log
The entire contents of the distribution log can be deleted by either of the following two methods: 
•	Right-click	in	the	Distribution	Log,	and	from	the	menu	that	appears,	click	[Delete	All	Distribution	Log].
•	Press	[Delete].
A	confirmation	dialog	box	will	appear.	Click	[OK].

Updating
The distribution log can be updated by either of the two following methods:
•	Right-click	in	the	Distribution	Log,	and	from	the	menu	that	appears,	click	[Refresh	the	Information].
•	Press	[F5].

Outputting CSV File of Distribution Log
The	distribution	log	can	be	output	as	a	CSV	file.
1. Right-click in the Distribution Log, and from the menu that appears, click [Output CSV File of 

Distribution Log].
The	[Select	the	CSV	file	you	want	to	write	down]	dialog	box	will	appear.

2. Enter a “File Name”, and click [Save].
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Schedule Management
 This function is only available with the Network Version.

Server Scheduler
Server	Scheduler	controls	reserved	distribution	schedules	that	have	been	reserved	with	“Schedule	Distribution	
Tool”,	and	distributes	schedules	to	the	target	PC	at	the	scheduled	time.

Server Scheduler is automatically started when Windows launches.
When Server Scheduler launches, an icon ( ) is displayed (and resides permanently) in the Task Tray.
Do	not	exit	Server	Scheduler	unnecessarily.
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Schedule Reception/Program Display
 This function is available on the Viewer Versions.

This	section	gives	details	for	target	PC	settings	when	schedules	and	programs	are	distributed	from	the	controller	
PC	using	the	Network	Version.

FTP Server
The	FTP	Server	receives	schedules	and	break-in	programs	from	the	controller	PC,	and	passes	them	to	the	
Client	Scheduler.	

●Launching the FTP Server
The	FTP	Server	launches	automatically	when	Windows	is	launched.
To	check	if	the	FTP	Server	service	is	started	or	not,	use	the	following	method:
• If using Windows XP
1. From the Windows Taskbar click [Start], [Control Panel], [Performance and Maintenance], 

[Administrative Tools], [Services].
The	[Services]	window	will	appear.

2. Check that the status of “SHARP LCD Monitor FTP Server” under “Services” is “Started”. 
If	the	service	is	not	started	click	“Start	the	Service”.

• If using Windows Vista
1. Right-click on an empty area of the Taskbar, and from the menu that appears, click [Taskbar].

The	[Windows	Task	Manager]	dialog	will	appear.
2. Click the [Processes] tab and confirm that “FTPD.exe” is displayed.

• If using Windows 7
1. Right-click on an empty area of the Taskbar, and from the menu that appears, click [Start Task 

Manager].
The	[Windows	Task	Manager]	dialog	will	appear.

2. Click the [Processes] tab and confirm that “FTPD.exe” is displayed.
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Client Scheduler
Client	Scheduler	is	used	on	the	target	PC.
It	loads	the	schedules	and	break-in	programs	that	have	been	received	by	the	FTP	Server,	and	controls	the	
Program	Viewer	to	display	specified	programs	at	the	specified	time.

●Launching Client Scheduler
Client	Scheduler	is	automatically	launched	by	“Startup”	when	Windows	launches.
When	Client	Scheduler	launches,	an	icon	( ) is displayed (and resides permanently) in the Task Tray. 

●Client Scheduler menu
The menu that appears when the icon in the Task Tray is 
right-clicked performs the following actions:

Setting
Clicking	the	[Setting]	menu	displays	the	[Setting	of	Client	Scheduler]	dialog	box.	The	tabs	in	this	dialog	box	
contain the following settings:

 [Program Viewer] tab
Contains	detailed	settings	for	the	Program	Viewer.
•	 You	can	view	programs	even	when	there	are	no	
programs	being	displayed	by	checking	the	“Paint	the	
program	view	area,	if	no	program	played.”	check	box.	Set	
the	display	content	by	clicking	[Paint	Setting].
·	 [Dark	blue]	option	button
	 Displays	the	area	defined	by	“Display	area”	settings	in	

dark blue.
·	 “Content	file”	option	button
	 Sets	the	content	file	path,	display	method,	and	
background	color	from	the	[Setting	of	the	contents	file]	
dialog	box	that	appears	when	[Setting]	is	clicked.

1)	Click	[Ref],	and	select	a	content	file.	You	may	select	
any	file	format	that	is	supported	by	this	product.

2)	Select	a	“Display	mode”	from	the	“Keeping	aspect	
ratio”,	“Not	keeping	aspect	ratio”,	or	“In	original	size”	
option buttons. 

3)	Set	the	“Background	color”.

·	 “Program”	option	button
	 Click	[Import],	and	select	an	existing	program.	You	may	
select	programs	that	have	been	exported	with	Program	
Editor.

Client Scheduler
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•	 The	area	set	under	the	[Display	Area]	tab	will	be	the	display	area	(except	when	a	program	is	specified).
•	 “Smooth	contents	change”	check	box
	 Check	this	check	box	to	switch	between	contents	smoothly	by	preparing	the	playback	of	the	next	
content	before	the	end	of	the	current	content.	Also	check	this	check	box	when	it	is	necessary	to	
synchronize	the	content	display	between	frames.

	 Clicking	[Preload	Setting]	allows	you	to	set	the	content	that	is	to	be	read	in	advance.

	 •	Making	the	switching	of	contents	smooth	will	
increase	the	load	on	the	CPU	and	the	memory	use	
amount. It is recommended that tests be conducted 
by actually displaying programs before operation. 

 •	When	performing	advanced	reading	of	a	content	
that can be played with Windows Media Player, 
the	video	accelerator	is	disabled.	Check	that	your	
PC	has	enough	performance	to	display	contents	
without the video accelerator. 

 •	If	a	content	that	can	be	played	with	Internet	
Explorer	is	read	in	advance,	Flash	contents	and	
banners embedded in the content may be started 
from the middle.

•	 “Set	limit	of	print	screen	area”	check	box
	 When	you	are	outputting	multiple	screens	on	a	target	PC,	
the	Screen	Capture	function	captures	the	entire	desktop.	
Check	this	box	to	capture	just	a	part	of	the	screen	output.

	 Click	[Area	Setting]	and	define	the	area	you	want	to	
capture.

•	 “Don’t	move	focus	while	program	viewer	starts”	check	box
	 This	box	is	usually	left	unchecked.
	 Check	this	box	if	you	do	not	want	the	Program	Viewer	focus	to	move	when	you	launch	the	Program	

Viewer.
•	 “Hide	task	bar	while	showing”	check	box	
	 When	this	check	box	is	checked,	the	task	bar	is	hidden	when	Program	Viewer	is	launched	and	it	is	

re-displayed when Program Viewer is closed.
•	 “My	Contents	folder”:	Enter	the	path	of	the	folder	in	which	contents	to	be	distributed	in	advance	are	to	be	

saved.

The initial default values are:
•	My	Contents	folder:	C:\Program	Files\SHARP\SHARP	Digital	Signage	Software\My	Contents\
	 (For	Windows	Vista/7,	C:\Program	Data\SHARP\SHARP	Digital	Signage	Software\My	Contents\)

Client Scheduler
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 [Display Area] tab
•	 “Display	area	for	distributed	program”
 When the display area of the program and the resolution 

of the panel are different, this tab allows you to display the 
program regardless of the display area set for the program. 

	 Check	the	“Always	display	the	distributed	program	in	the	
following	area”	check	box	and	set	the	area	in	which	the	
program is to be displayed.

 [Power Control] tab
Manages	power	on	target	PCs	currently	being	configured.
•	 “Shutdown	on	the	designated	time”	check	box
 Check	this	box	to	turn	off	the	target	PC	at	the	specified	time.
•	 “Reboot	on	the	designated	time”	check	box
 Check	this	box	to	restart	the	target	PC	at	the	specified	time.

 [FTP Server] tab
Sets	the	FTP	Server.
•	 “User	name”:	Must	be	kept	within	30	alphanumeric	

characters.
•	 “Password”:	Must	be	kept	within	30	alphanumeric	

characters.
•	 “Port	Number”:	Enter	a	value	between	1	and	32000.

	 If	you	have	installed	the	Viewer	Version,	a	unique	FTP	Server	will	be	installed,	and	started	as	a	
service.	The	default	TCP/IP	port	numbers	are	20	and	21.	If	this	port	number	is	already	used	by	
another	service,	change	the	port	number.	The	FTP	settings	of	the	panels	registered	with	“Panel	
Management”	on	the	control	PC	must	use	the	same	port	number.	(Fp.80)

 [Panel Control] tab
•	 “No	panel”	option	button
 Panels will not be controlled.
•	 “Single	panel”	option	button
	 Click	[Connection	Setting]	and	select	the	panel	control	
method	(RS-232C/LAN).

•	 [Connection	Setting]
	 Select	either	“RS-232C”	or	“LAN”	from	the	[Connecting	
interface]	option	buttons.

Setting Description Default

RS-232C
COM	port COM1~COM256 COM1
Baud Rate 9600,	19200,	38400 9600

LAN

Host name or IP 
address

Enter	the	host	name	or	the	IP	address	of	the	panel	to	be	
controlled	within	32	alphanumeric	characters.

-

Data port
Enter	a	data	port	number	between	1025	and	65535	for	the	
panels to be controlled.

10008

User	name
Enter	the	username,	if	one	exists	for	the	panels	to	be	
controlled,	in	8	characters	or	less.

-

Password
Enter	the	password,	if	one	exists	for	the	panels	to	be	
controlled,	in	8	characters	or	less.

-

Client Scheduler
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•	 [Test	connection]
	 Check	the	connection	to	confirm	that	the	panel	can	be	controlled.	After	the	connection	is	established	
successfully,	the	model	name	of	the	panel	is	acquired	and	displayed.	Perform	operation	with	the	power	
of	the	panel	turned	on.	To	control	the	panel	with	the	LB-1085,	be	sure	to	check	the	connection	once.	The	
panel	cannot	be	controlled	unless	a	“Test	connection”	is	performed.

•	 “Multiple	Panels”	option	button
	 You	can	select	and	control	panels	from	up	to	25	panels.	You	can	also	set	power	control,	entry	method,	
timing,	and	PIP	functions.	In	addition,	you	can	acquire	the	status	of	each	panel	and	other	information.
•	 [Connection	Setting]
 A list of connected panels appears when you click 
[Connection	Setting].

	 Add	panels	to	the	list	the	first	time	you	use	this	function	
by	clicking	[Add].

Setting Description Default

RS-232C
COM	port COM1~COM256 COM1
Baud Rate 9600,	19200,	38400 9600

LAN

Host name or IP 
address

Enter	the	host	name	or	the	IP	address	of	the	panel	to	be	
controlled	within	32	alphanumeric	characters.

-

Data port
Enter	a	data	port	number	between	1025	and	65535	for	the	
panels to be controlled.

10008

User	name
Enter	the	username,	if	one	exists	for	the	panels	to	be	
controlled,	in	8	characters	or	less.

-

Password
Enter	the	password,	if	one	exists	for	the	panels	to	be	
controlled,	in	8	characters	or	less.

-

Panel IDs
Select	IDs	in	order	to	identify	panels	when	PCs	are	connected	
in a daisy chain.
(Do	not	connect	in	a	daisy	chain),	1-255

(Do not 
connect in a 
daisy chain)

•	 “Power	ON	the	panel	before	starting	up	this	software.”	check	box
	 When	this	check	box	is	checked,	the	power	of	the	panel	is	turned	on	when	the	Client	Scheduler	is	

started.
	 *		The	function	of	turning	on	the	power	of	the	panel	cannot	be	used	with	the	LB-46GX35	and	

LB-52GX35.
•	 “Power	OFF	the	panel	before	exiting	this	software.”	check	box
	 When	this	check	box	is	checked,	the	power	of	the	panel	is	turned	off	when	the	Client	Scheduler	is	

terminated.
•	 “Synchronize	the	panel	time	with	PC	time	before	starting	up	this	software.”	check	box
	 When	this	check	box	is	checked,	the	clock	of	the	panel	is	set	to	the	time	of	the	target	PC	when	the	Client	

Scheduler is launched. 

Client Scheduler
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[USB Distribute] tab
Sets	the	details	of	USB	distribution.

•	 “Show	time	of	the	dialog	to	cancel	distribution”
 If you set a time longer than one second, the distribution 
cancel	dialog	box	is	displayed	when	USB	memory	or	
another	external	storage	device	is	inserted.

	 If	you	click	[Yes]	in	the	distribution	cancel	dialog	box,	
distribution	is	canceled.		Remove	USB	memory	or	
another	external	storage	device	using	the	safe	removal	
icon ( ) in the Task Tray.

•	 “Normal	mode”	option	button
	 Select	this	button	to	perform	USB	distribution	with	
“Schedule	Distribution	Tool”	(Fp.104).	

•	 “Contents	direct	distribute	mode”	option	button
	 Select	this	button	to	perform	USB	distribution	with	“Contents	direct	distribute	mode”	(Fp.104).
•	 “USB	memory’s	folder	to	distribute”
	 If	you	perform	distribution	with	“Contents	direct	distribute	mode,”	enter	the	path	of	the	folder	of	the	USB	

memory containing the content.

Displaying the log
Click	the	[View	the	Log]	menu	to	display	a	log	of	Client	Scheduler	
operations.
The log can be cleared and updated.

Pausing a program
Clicking	the	[Pause	to	View	Program]	menu	will	pause	the	currently	displayed	program.	When	the	program	
is	paused	a	check	mark	will	be	displayed	to	the	left	of	the	menu.	Clicking	[Pause	to	View	Program]	again	will	
restart program display.

Deleting Schedule Information
Click	the	[Delete	Schedule	Information]	menu.	A	confirmation	
message	will	appear.	Click	[Yes]	to	delete	all	registered	schedule	
information	currently	saved	in	Client	Scheduler.

Deleting Break-in Program Information
Click	the	[Delete	Break-in	Program	Information]	menu.	A	confirmation	message	will	appear.	Click	[Yes]	to	delete	
all	registered	break-in	program	information	currently	saved	in	Client	Scheduler.

Get data from management PC
Target	PCs	receive	data	from	the	controller	PC	when	you	click	the	[Get	data	from	management	PC]	menu.
This	function	can	only	be	used	with	“Pull-based	data	delivery.”

Client Scheduler
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Version information
Click	the	[Version]	menu.	The	Client	Scheduler	[Version]	dialog	
box	will	appear.

	 	 You	may	be	asked	to	provide	version	information	in	
the event that you need to contact SHARP regarding a 
problem with SHARP Digital Signage Software.

If you input a temporary license code when installing, you will 
only be able to use the software for a two-month trial period. 
Register your license code before the end of the trial period.
For	instructions	on	how	to	register	License	Codes	refer	to	p.82.

Exiting Client Scheduler
To	exit	Client	Scheduler,	click	the	[Exit	Client	Scheduler]	menu.
Do	not	exit	Client	Scheduler	unnecessarily.

Distributing content directly by using USB memory or another external storage device
The	content	can	be	displayed	simply	by	inserting	USB	memory	or	another	external	storage	device	containing	
copied	content	into	the	target	PC.

	 •	Do	not	remove	the	USB	memory	or	another	external	storage	device	from	the	PC	before	transfer	is	
completed.

 •	Depending	on	the	external	storage	device	such	as	USB	memory,	distribution	cannot	be	performed	
successfully.

1. Set the target PC to “Contents direct distribute mode.”
1)	Click	the	icon	( )	in	the	Task	Tray	in	the	target	PC	and	click	the	[Setting]	menu.
2)	Click	the	[USB	Distribute]	tab	and	select	the	“Contents	direct	distribute	mode”	option	button	(Fp.92).
3)	Set	“USB	memory’s	folder	to	distribute”	as	required.
4)	Click	[OK].

Distributing content directly by using USB memory or another external storage device
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2. Copy the content to be distributed to USB memory or another external storage device.
Copy	the	content	to	the	folder	set	in	Step	1-(3).
The contents placed in folders lower than the set folder are not displayed.

	 •	In	the	Contents	direct	distribute	mode,	HTML	files	cannot	be	displayed.
 •	Contents	are	executed	in	ascending	order	of	the	file	names.
 	 By	attaching	a	serial	number	such	as	“001,”	“002,”	…,	at	the	head	of	each	file	name,	the	order	of	play	

can be set.
 •	The	play	time	of	content	is	usually	10	seconds.	For	video,	it	is	the	time	until	play	is	completed. 

By	appending	“_[numerical	value]m”	(minutes)	or	“_[numerical	value]s”	(seconds)	to	the	file	name	of	the	
content,	the	play	time	of	the	content	can	be	set	(24	hours	maximum).	 
[Example]	If	image_30s.jpg	is	specified,	the	content	is	displayed	for	30	seconds.

 •	By	placing	Telop.txt	(text	file)	in	the	specified	folder,	its	contents	can	be	displayed	as	scroll	messages.

3. Remove the external storage device such as USB memory from the PC. 
Remove it from the safe removal icon ( ) in the Task Tray.

4. Insert the external storage device such as USB memory into the target PC.
The	content	will	be	distributed	automatically.	After	distribution	is	complete,	the	external	storage	device	such	
as	USB	memory	stops	automatically.	Check	the	message	and	remove	it.

Program Viewer
Program	Viewer	is	used	on	the	target	PC.
It	displays	programs	based	on	schedules	and	break-in	programs	loaded	by	Client	Scheduler.

	 •	To	pause	a	program,	right-click	the	Client	Scheduler	icon,	and	from	the	menu	that	appears,	click	[Pause	
to	View	Program].	

 •	To	change	advanced	settings	for	Program	Viewer,	right-click	the	Client	Scheduler	icon	and	from	the	
menu	that	appears,	click	[Setting].	Settings	can	be	adjusted	from	the	[Setting	of	Client	Scheduler]	dialog	
box	that	appears.	(Fp.99)
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Key/Mouse Monitoring
 This function is available with the Viewer Versions.

This	section	explains	the	function	of	switching	displayed	programs	using	keyboard	and	mouse	operations.

Key/Mouse Monitoring Tool Window

●Launching the Key/Mouse Monitoring Tool window
1. From the Windows Taskbar, click [Start], [All Programs], [SHARP Digital Signage Software], [Tools] 

and then [Key-Mouse Watcher].
The key/mouse monitoring tool launches and an icon ( ) is displayed (and remains permanently) in the 
Task Tray.

●Key/Mouse Monitoring Tool menu
From	the	menu	that	appears	when	the	icon	in	the	Task	Tray	is	
right-clicked, the following operations can be performed.

Configuration
Set	the	operation	mode	of	the	Key/Mouse	Monitoring	Tool.

•	 “Disable”	option	button
	 Disables	the	operation	of	the	Key/Mouse	Monitoring	Tool.
•	 “Screen	Saver	Mode”	option	button
 If a keyboard or mouse operation is performed, display of 

the program is stopped temporarily.
 If a keyboard or mouse operation is not performed for a 

certain period of time, the distributed program is displayed.
	 By	clicking	[Configuration],	the	following	setting	can	be	

performed.
 The period of time before the program display is 

resumed
	 The	program	display	is	resumed	by	pressing	the	[Ctrl],	
[Alt],	and	[V]	keys.

•	 “Change	Program	Mode”	option	button
 By assigning an action to a combination of keys, the 

action can be performed by key operation.
	 Up	to	20	actions	can	be	assigned.
 Set the key assignment and action by clicking 
[Configuration].
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1) Click the option to be edited and click [Edit].
A	dialog	box	will	appear.

2) Set the options.
•	“Key	Setting”
 Set the combination of keys to be registered.
•	“Operation”
 Set the action of the registered key.
•	If	you	select	“View	preset	program,”	specify	the	ID	number	of	
the	preset	program	to	be	displayed	in	“ID	of	preset	prg.”.

 If the preset program has not been imported, specify the ID 
number and import the program.

1)	Enter	a	number	in	“ID	of	preset	prg.”.
2)	Click	[Import].	
3)	Specify	the	exported	program	data	and	click	[Open]. 

The	program	is	imported	to	the	specified	preset	number	ID.

•	If	you	select	“Run	application,”	enter	the	path	of	the	application	to	be	executed	in	“Path.”	It	is	also	possible	to	
enter	“Option.”

3) Click [OK]. 

	 •	If	the	same	key	is	assigned	to	different	IDs,	the	assigned	action	is	performed	in	ascending	order	of	IDs.
 •	If	the	[Ctrl]	key	is	pressed	when	PowerPoint	Viewer	is	launched,	PowerPoint	content	is	not	displayed	in	

the correct position. Take care when displaying a program containing PowerPoint content.

•	“Change	program,	if	a	mouse	event	comes	when	it	shows	scheduled	program.”	check	box.
	 When	this	check	box	is	checked,	actions	are	assigned	to	mouse	operations	so	that	actions	can	be	performed	

by operating the mouse.
1) Click [Detail]. 
“Assign	for	mouse	input”	will	appear.

2) Set the options.
•	“Operation”
 Set the action of the registered mouse operation.
•	If	you	select	“View	preset	program,”	specify	the	ID	number	of	
the	preset	program	to	be	displayed	in	“ID	of	preset	prg.”.

 If the preset program has not been imported, specify the ID 
number and import the program.

1)	Enter	the	ID	number	in	“ID	of	preset	prg.”.
2)	Click	[Import].	
3)	Specify	the	exported	program	data	and	click	[Open].

•	If	you	select	“Run	application,”	enter	the	path	of	the	application	to	be	executed	in	“Path.”	It	is	also	possible	to	
enter	“Option.”

3) Click [OK].

	 •	“Program”	refers	to	a	scheduled	program	or	a	break-in	program.	When	a	preset	program	is	being	
displayed, the assigned action cannot be performed.

Key/Mouse Monitoring Tool Window

Download from Www.Somanuals.com. All Manuals Search And Download.



108

Key/Mouse Monitoring Tool

•	“Play	program	again,	if	no	input	has	come	for	a	certain	time”	check	box 
When	this	check	box	is	checked,	the	normal	program	is	resumed	if	the	key	or	mouse	is	not	operated	for	a	
certain period of time.

1) Click [Detail]. 
The	“Configuration	for	Restart	Program”	dialog	box	will	appear.

2) Set the options.
•	“Time	to	restart	program	after	last	key	event”
 Set the period of time before program display is resumed.
•	“Execute	an	application	when	the	program	restart.”	check	box
	 If	you	check	this	check	box,	enter	the	path	of	the	application	
to	be	executed	in	“Path.”	It	is	also	possible	to	enter	“Option.”

3) Click [OK].

About
Displays	the	version	of	the	Key/Mouse	Monitoring	Tool.

Exit
Exits	the	Key/Mouse	Monitoring	Tool.

Key/Mouse Monitoring Tool Window
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 This function is only available with the Network Version.

The	Status	Monitoring	Tool	allows	you	to	check	panel	status	and	control	target	PC	power.

The main Status Monitoring Tool window

●Launching Status Monitoring Tool
1. From the Windows Taskbar, click [Start], [All Programs], [SHARP Digital Signage Software], [Tools], 

[Status Monitoring Tool].
“Status	Monitoring	Tool”	will	launch.

●The main Status Monitoring Tool window
1)	Menus

2)	Toolbar

3)	Group	tree

4)	Panel	list

1) Menus
Menu options are as follows:

Menu option Description Relevant 
page

File Exit Exits	Status	Monitoring	Tool. -

Panel

Select all panels Selects all panels displayed in the panel list. Fp.112
Select panels without 
response

Selects all panels in the panel list that are not responding 
(including	panels	for	which	status	has	not	been	acquired).	 Fp.112

Select panels with 
response

Selects all panels in the panel list that are responding. Fp.112

Monitoring status
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The main Status Monitoring Tool window

Menu option Description Relevant 
page

Panel

Power control 
of	controller	PC

Power on Turns	on	the	target	PC	of	selected	panels. Fp.113
Reboot Restarts	the	target	PC	of	selected	panels. Fp.113
Power off Turns	off	the	target	PC	of	selected	panels. Fp.113

Status	acquisition	of	
selected panels

Starts	status	acquisition	of	selected	panels.	 Fp.112

Property
Displays panel status details if only one panel is selected. 
This	function	can	be	used	only	with	the	SHARP	LCD	
monitor (PN series).

Fp.114

Option

Operation environment Displays	the	[Setting	of	operation	environment]	dialog	box. Fp.116
Panel setting without status 
acquisition

Displays	the	[Panel	setting	without	status	acquisition]	dialog	
box. Fp.113

Thumbnail	size

Small
Changes	the	size	of	thumbnails	displayed	in	the	panel	list	
to Small. Fp.115

Medium
Changes	the	size	of	thumbnails	displayed	in	the	panel	list	
to Medium. Fp.115

Large
Changes	the	size	of	thumbnails	displayed	in	the	panel	list	
to	Large.	 Fp.115

Start	of	status	acquisition
Starts	status	acquisition	of	all	panels	registered	in	Panel	
Management	(except	for	panels	set	without	status	
acquisition). 

Fp.112

Cancel	of	status	acquisition Cancels	panel	status	acquisition. Fp.112
Help About Status Monitoring Tool Displays version information for Status Monitoring Tool. -

2) Toolbar
The toolbar buttons (icons) perform the following actions:

Icon Menu option Description Relevant 
page

Power on Turns	on	the	target	PC	of	selected	panels. Fp.113

Rebot Restarts	the	target	PC	of	selected	panels. Fp.113

Power off Turns	off	the	target	PC	of	selected	panels. Fp.113

Show the panel information
Displays panel status details if only one panel is selected. 
This	function	can	be	used	only	with	the	SHARP	LCD	
monitor (PN series).

Fp.114

Small thumbnail
Changes	the	size	of	thumbnails	displayed	in	the	panel	list	
to Small. Fp.115

Medium thumbnail
Changes	the	size	of	thumbnails	displayed	in	the	panel	list	
to Medium. Fp.115

Large	thumbnail
Changes	the	size	of	thumbnails	displayed	in	the	panel	list	
to	Large.	 Fp.115

Start	of	status	acquisition
Starts	status	acquisition	of	all	panels	registered	in	Panel	
Management	(except	for	panels	set	without	status	
acquisition).	

Fp.112

Cancel	of	Status	
acquisition

Cancels	panel	status	acquisition. Fp.112
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3) Group tree
Displays groups registered in Panel Management.(Fp.78)
When	a	group	is	selected,	all	the	panels	that	belong	to	it	(except	for	panels	set	without	status	acquisition)	are	
displayed in the panel list.
When	“(Select	all	panels)”	is	selected,	all	panels	(except	for	panels	set	without	status	acquisition)	are	displayed	
in the panel list.

4) Panel list
Displays	a	list	of	all	panels	in	the	selected	groups	in	the	group	tree	(except	for	panels	set	without	status	
acquisition).
Panel icons and thumbnails change according to panel status.

Panel icon/thumbnail Description

Displayed	when	the	statuses	of	the	panel	and	the	target	PC	have	not	been	acquired.

Displayed	when	there	is	no	response	from	the	target	PC.

Displayed	when	there	is	a	response	from	the	target	PC,	but	screen	captures	of	the	
currently	displayed	screen	cannot	be	acquired.

(Example	image	only)
This warning icon will appear 

when there is an error in 
acquiring	IDP	status	(e.g.	
power-off, hardware error, 

etc.).

Displayed	when	there	is	a	response	from	the	target	PC	and	screen	captures	of	the	
currently	displayed	screen	can	be	acquired.
*		Thumbnails	of	acquired	screen	captures	will	be	displayed.	(It	differs	depending	on	
the	display	of	the	target	PC.)

*		To	acquire	an	image	capture	of	the	screen,	check	“Acquisition	of	screen	capture	
displaying	by	controller	PC”	in	the	[Setting	of	operation	environment]	dialog	box.	
(Fp.105)

The main Status Monitoring Tool window
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Acquiring and displaying panel status

Acquiring and displaying panel status

●Acquiring status of selected panels

1. Select a group from the group tree, and then select a 
panel from the panel list.

	 •	To	select	all	panels	in	the	panel	list,	either	click	
[Select	all	panels]	from	the	[Panel]	menu,	or	press	
[Ctrl]	+	[A].	

 •	To	select	all	panels	in	the	panel	list	that	are	not	responding	(including panels for which status has not 
been	acquired),	either	click	[Select	panels	without	response]	from	the	[Panel]	menu,	or	press	[Ctrl]	
+	[Shift]	+	[A].

 •	To	select	all	panels	in	the	panel	list	that	are	responding,	either	click	[Select	panels	with	response]	
from	the	[Panel]	menu,	or	press	[Ctrl]	+	[Alt]	+	[A].

2. From the [Panel] menu, click [Status acquisition of selected panels].
Status	acquisition	of	selected	panels	will	start.

	 •	To	acquire	panel	status	for	all	panels	registered	in	Panel	Management	(except	for	panels	set	
without	status	acquisition),	click	[Start	of	status	acquisition]	from	the	[Option]	menu,	or	alternatively,	
click .

 •	To	cancel	panel	status	acquisition,	click	[Cancel	of	status	acquisition]	from	the	[Option]	menu,	or	
alternatively, click .

When	panel	status	is	acquired,	panel	icons	and	thumbnails	
will change.
The image can be enlarged by double-clicking it.
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●Setting panels for which status will not be obtained
It	is	possible	to	set	panels	for	which	status	will	not	be	acquired	so	that	they	will	not	be	displayed	in	the	panel	list.
1. From the [Option] menu click [Panel setting without status acquisition].

2. Select panels from the “Panel list with getting status”.

3. Click [Add].

The	selected	panels	will	move	to	the	“Panel	list	without	
getting	status”.

4. Click [OK].

	 To	reset	a	panel	so	that	its	status	will	be	acquired,	
select	it	from	the	“Panel	list	without	getting	status”,	
and	click	[Remove].

●Controlling target PC power
The	target	PC	can	be	turned	on	and	off,	and	restarted.

1. Select a group from the group tree, and then select a 
panel from the panel list.

2. To turn the target PC on, from the [Panel] menu, click [Power control of controller PC] and then 
[Power on], or alternatively, click .

 To restart the target PC, from the [Panel] menu, click [Power control of controller PC] and then 
[Reboot], or alternatively, click

 
.

 To turn the target PC off, from the [Panel] menu, click [Power control of controller PC] and then 
[Power off], or alternatively, click .
A	confirmation	dialog	box	will	appear.

3. Click [Yes]. 
The	process	will	be	executed.

Acquiring and displaying panel status
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4. A screen like the one on the right will appear. Check that 
the distribution was successful and click [Close].

●Displaying detailed information for a panel
1. Select a group from the group tree, and then select a 

panel from the panel list.

2. From the [Panel] menu click [Property], or alternatively, click .
The	[Panel	property]	dialog	box	will	appear.

3. Check the settings, and click [Close].

	 •	To	display	“Panel	(PN	series)	status,”	check	“Status	acquisition	of	panel	(PN	series)”	in	the	[Setting	
of	operation	environment]	dialog	box	(Fp.116)
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●Changing thumbnail size
It	is	possible	to	change	the	size	of	the	thumbnails	of	the	screen	captures	acquired	from	the	panels.

1. Click the buttons on the toolbar.  
(Small: 

 
, Medium: 

 
, Large: 

 
)  

Or alternatively, from the [Option] menu, click [Thumbnail size], and select the size you want to use.
	 Small	 Medium	 Large

   

Acquiring and displaying panel status
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Setting the operation environment
Set	advanced	settings	for	panel	status	acquisition.

1. From the [Option] menu click [Operation environment].
The	[Setting	of	operation	environment]	dialog	box	will	appear.

2. Set the options.
1)	Check	the	“Response	confirmation	of	controller	PC	

through	ICMP	ECHO	packet”	check	box.		(Compulsory)

	 The	check	box	cannot	be	cleared.

•	Timeout	(seconds)	  
Sets	the	timeout	value	for	confirming	a	response	from	
the	target	PC.	Values	of	from	1-10	seconds	can	be	
selected. 

•	Retry	count	  
Sets	the	number	of	retries	permitted	when	confirming	
a	response	from	the	target	PC.	Values	of	from	1-10	
times can be selected.

	 If	there	is	no	response,	a	delay	of	“timeout	value	x	number	of	retries”	seconds	will	occur.

2)	 “Acquisition	of	displaying	program	information”	check	box
	 Check	this	box	to	acquire	information	about	the	currently	displayed	program	from	the	target	PC.

3)	 “Acquisition	of	screen	capture	displaying	by	controller	PC”	check	box
	 Check	this	box	to	acquire	the	currently	displayed	screen	capture	from	the	target	PC.	The	acquired	

screen captures will be displayed as thumbnails.

	 It	may	not	always	be	possible	to	acquire	screen	captures	of	movies.

4)	 “Status	acquisition	of	panel	(PN	series)”	check	box
	 Check	this	box	to	acquire	information	about	the	panel	from	the	target	PC.
	 This	function	can	be	used	only	with	the	SHARP	LCD	monitor	(PN	series).

5)	 “Acquisition	of	license	information”	check	box
	 Check	the	check	box	to	view	the	license	code	and	the	file	version	of	the	SHARP	Digital	Signage	

Software viewer version.

6)	 “Auto	acquisition	under	the	following	interval”	check	box
Check	this	box	to	automatically	acquire	panel	status	at	regular	intervals.
•	Acquisition	interval	  
Set	the	interval	at	which	you	want	to	obtain	panel	status.	Values	of	1-60	minutes	can	be	set.

3. Click [OK].

Setting the operation environment
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